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LICENCE AGREEMENT
Canon Software License Agreement

Read carefully the terms and conditions of use given below before using the Software. By using the 
Software you agree to abide by the following terms and conditions of use and enter into a legal 
agreement with Canon Inc. ("Canon"):

1. The title to and all rights of the Software and reproductions thereof are reserved to Canon or 
Canon's licensors depending on the contents.

2. Canon hereby grants the Software's users ("the User") a non-exclusive license to use the Software 
for use with certain Canon's Products compatible with the Software.

3. The User shall not modify, alter, reverse engineer, decompile, disassemble or otherwise change any 
part or all of the Software.

4. Canon, Canon's subsidiaries and Canon's licensors extend no warranties of any kind as to the 
Software including but not limited to warranties of fitness or usefulness for the User's particular 
purposes and lack of defects.

5. In no event shall Canon, Canon's subsidiaries or Canon's licensors be liable for any direct, indirect 
or other losses or damages whatsoever arising out of, incidental to or in connection with the use of 
the Software.

6. The User shall not export, directly or indirectly, any part or all of the Software without obtaining 
necessary approvals from the Japanese government or the governments concerned.
The User shall not export or re-export any part of the Software to any country the U.S. government 
prohibits exports to.
The User shall not export or re-export any part of the Software to any person or organization the 
U.S. government prohibits any trade with.
The User shall not provide the Software for any person from the country the U.S. government 
prohibits exports to.



            
How This Manual Is Organized

● Notice

• To view the manuals in PDF format, Adobe Reader/Adobe Acrobat Reader is 
required. If Adobe Reader/Adobe Acrobat Reader is not installed on your 
system, please download it from the Adobe Systems Incorporated website.

Before You Start

Setting Up the Network Environment for Printing

Managing the Printer in the Network Environment

Troubleshooting

Appendix

A list of the network setting items, specifications of the network board, index, and 
others are provided.

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Chapter 5
Considerable effort has been made to ensure that this manual is free of inaccuracies and omissions. However, as we are constantly improving our 
products, if you need an exact specification, please contact Canon.



                   
Contents
Preface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

How To Use This Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
Symbols Used in This Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
Buttons Used in This Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
Displays Used in This Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi
Abbreviations Used in This Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

Legal Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Trademarks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Copyright  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Disclaimers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii

Chapter 1 Before You Start

Checking the Network Environment. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

Requisite Tasks Before Printing or Managing the Printing Operation  . . . . . 1-3
Configuring the Printer to Print in a Network Environment. . . . . . . . . . . . . . . 1-3

Installing the Printer Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
Performing the Protocol Settings for the Printer . . . . . . . . . . . . . . . . . . . . 1-4

Managing the Printer in the Network Environment. . . . . . . . . . . . . . . . . . . . . 1-5

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Printer Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Canon CAPT Print Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-6
Remote UI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
NetSpot Device Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-8

Chapter 2 Setting Up the Network Environment for Printing

Installing the CAPT Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Installing the CAPT Software from CD-ROM Setup . . . . . . . . . . . . . . . . . . . . 2-2

For LBP5100. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
For LBP5000, LBP3500, or LBP3300 . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-16

Installing the Printer Driver Manually Using Various Utility Software . . . . . . 2-29
IP Address Setting Using NetSpot Device Installer . . . . . . . . . . . . . . . . 2-30
IP Address Setting Using the ARP/PING Command . . . . . . . . . . . . . . . 2-40
IP Address Setting Using the Printer Status Window . . . . . . . . . . . . . . . 2-42
Installing the Canon CAPT Print Monitor  . . . . . . . . . . . . . . . . . . . . . . . . 2-45
Installing the Printer Driver from the 
[Printers and Faxes] Folder or the [Printers] Folder . . . . . . . . . . . . . . . . 2-50
ii



                   
After Completing Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-79
For Windows XP/Server 2003 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-79
For Windows 98/Me/2000  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-80

Checking the Operations with Network Status Print . . . . . . . . . . . . . . . . . . .2-81

Protocol Settings for the Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-84
Protocol Settings Using the Remote UI . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-84
Protocol Settings Using NetSpot Device Installer  . . . . . . . . . . . . . . . . . . . . .2-92
Protocol Settings Using FTP Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-98

Uninstalling the CAPT Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-100
Uninstalling the Printer Driver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-100
Uninstalling Canon CAPT Print Monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . .2-102
Uninstalling NetSpot Device Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-104

Chapter 3 Managing the Printer in the Network Environment

Managing the Printer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-2

Managing the Printer Using the Remote UI. . . . . . . . . . . . . . . . . . . . . . . . . . . .3-3
Restricting the Users Who Can Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-4
Restricting the Users Who Can Monitor/
Change the Settings Using the SNMP Protocol. . . . . . . . . . . . . . . . . . . . . . . .3-8
Restricting the Users Who Can Perform the Multicast Discovery  . . . . . . . . .3-13
Restricting the Devices That Can Access with MAC Addresses . . . . . . . . . .3-17
Obtaining/Checking the Security Access Logs  . . . . . . . . . . . . . . . . . . . . . . .3-21

Obtaining a Security Access Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-21
Checking the Security Access Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-25

Initializing the Network Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-28

Managing the Printer Using FTP Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-31

Managing the Printer Using NetSpot Device Installer . . . . . . . . . . . . . . . . . .3-34
Configurable Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-34
Installing NetSpot Device Installer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-35
Running NetSpot Device Installer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-40

When Running NetSpot Device Installer Installed on a Computer  . . . . .3-40
When Running NetSpot Device Installer from the 
CD-ROM Supplied with the Network Board . . . . . . . . . . . . . . . . . . . . . . .3-41

How to Use NetSpot Device Installer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3-43

Chapter 4 Troubleshooting

Installation Problems  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-2
Problems on Local Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-3
Printing a Test Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-4
When Uninstallation Fails. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-5

When Data is Not Sent to the Printer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-8

Miscellaneous Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-11

Checking the Network Board Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . .4-16
iii



         
Chapter 5 Appendix

Network Setting Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2

Software That Can Be Used for the Network Settings . . . . . . . . . . . . . . . . . . 5-7

Setting the Network Board . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8

Initializing the Network Settings. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12

Settings for Adding a Port. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-16

Changing the Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-18
For Standard TCP/IP Port (Only for LBP5100). . . . . . . . . . . . . . . . . . . . . . . 5-18
For Canon CAPT Print Monitor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-22

Using the Unicast Communication Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-26
Unicast Communication Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-26
Setting the Network Board to Enter into the Unicast Communication Mode . . . 5-27

Updating the Firmware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-29

Specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-32
Hardware Specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-32
Software Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-32

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-33
iv



            
Preface
Thank you for purchasing this Canon product. 
Please read this manual thoroughly before operating the printer in order to familiarize 
yourself with its capabilities, and to make the most of its many functions. 
After reading this manual, store it in a safe place for future reference.

How To Use This Manual

Symbols Used in This Manual
The following symbols are used in this manual to indicate operational requirements 
or clarification.

IMPORTANT Indicates operational requirements and restrictions. 
Be sure to read these items carefully in order to operate the printer 
correctly, and to avoid damage to the printer.

NOTE Indicates a clarification of an operation, or contains additional 
explanations for a procedure. 
Reading these notes is highly recommended.

Buttons Used in This Manual
The following button names are a few examples of how buttons to be pressed are 
expressed in this manual:

• Buttons on Computer Operation Screen: [Button Name]
Example: [OK]

[Details]
v



                              
Displays Used in This Manual
Displays used in this manual may differ from those on your computer depending on 
the system environment.

The buttons which you should press are marked with a  as shown below.

When multiple buttons can be pressed on the screen shot of computer operation 
screen, all buttons are marked. Select the button which suits your needs.

Abbreviations Used in This Manual
In this manual, product names and model names are abbreviated as follows:

Microsoft® Windows® 98 operating system: Windows 98

Microsoft® Windows® Millennium Edition operating system: Windows Me

Microsoft® Windows® 2000 operating system: Windows 2000

Microsoft® Windows® XP operating system: Windows XP

Microsoft® Windows ServerTM 2003 operating system: Windows Server 2003

Microsoft® Windows® operating system: Windows

9           Click [Next].

Click this button for operation.
vi



      
Legal Notices
Trademarks
Canon, the Canon logo, LBP, and NetSpot are trademarks of Canon Inc.

Adobe, Adobe Acrobat, and Adobe Reader are trademarks of Adobe Systems 
Incorporated.

IBM and AT are trademarks of International Business Machines Corporation.

Microsoft, MS-DOS, and Windows are registered trademarks of Microsoft 
Corporation in the United States and other countries.

Windows Server is a trademark of Microsoft Corporation.

Ethernet is a trademark of Xerox Corporation.

Other product and company names herein may be the trademarks of their 
respective owners.

Copyright
Copyright 2007 by Canon Inc. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying and recording, or by any 
information storage or retrieval system without the prior written permission of 
Canon Inc.
vii



   
Disclaimers
The information in this manual is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS 
MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, 
INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO 
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PATENT. CANON 
INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES 
RESULTING FROM THE USE OF THIS MATERIAL.
viii



         
CHAPTER

1
Before You Start
This chapter describes a brief overview of the requisite tasks to perform and the system 
environment of the software for printing or managing the printing operation in a network 
environment.

Checking the Network Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

Requisite Tasks Before Printing or Managing the Printing Operation . . . . . . . . . . . . . . . .1-3
Configuring the Printer to Print in a Network Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-3

Managing the Printer in the Network Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-5

System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-6
Printer Driver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-6

Canon CAPT Print Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-6

Remote UI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-7

NetSpot Device Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-8
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Checking the Network Environment
By installing the network board in the printer, you can use the printer in the network 
environment as shown in the following figure. The network board supports the TCP/
IP protocols.

* If you connect the printer via a print server, you can use it as a network printer, which enables printing from other 
computers that are not directly connected to the printer. 
If you connect the printer via a print server, you need to perform the following settings:

1. Installing the printer driver on the print server (See p. 2-2)
2. Print Server Settings (See User's Guide)
3. Installation on Clients (See User's Guide)

Print Server 

Client 

Client 

Client 

Client 

Printer

Printer

Connecting the printer directly to the computer

Connecting the printer to the computer via a print server

:TCP/IP

:TCP/IP
:Usable Protocols
1-2 Checking the Network Environment
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Configuring the Printer to Print in a Network Environment
The following shows the tasks that should be performed after installing the printer 
and optional network board.

■ Installing the Printer Driver
* There are two ways to install the printer driver: "Auto Setup" and "Manual Setup".

"Auto Setup" allows you to easily configure the printer to print in a network environment by setting the IP 
address, creating a port, and installing the printer driver at once.

<Auto Setup> <Manual Setup>

Installing from 
CD-ROM Setup

 (See p. 2-2)
∗ You can set the IP 

address, create a 
port, and install the 
printer driver at once.

IP Address Setting

IP Address Setting 
Using NetSpot 

Device Installer (See 
p. 2-30)

IP Address Setting 
Using the ARP/PING 

Command (See p. 
2-40)

* If you are using 
Windows XP Service 
Pack 2 or another 
operating system 
equipped with 
Windows Firewall, set 
the IP address using 
the ARP/PING 
command.

IP Address Setting 
Using the Printer 

Status Window (See 
p. 2-42)

* You can set the IP 
address from the 
Printer Status 
Window if the printer 
driver has already 
been installed by the 
USB connection.

Creating a Port (Canon CAPT Port)

Installing Canon CAPT Print Monitor Using Print Monitor Installer 
(See p. 2-45)

If you are using LBP5100 with Windows 2000/XP/Server 2003, you can 
specify Standard TCP/IP Port also. If you specify Standard TCP/IP Port, you 
do not need to install Canon CAPT Print Monitor.

Installing the Printer Driver

Installing the Printer Driver from the [Printers and Faxes] Folder or 
the [Printers] Folder (See p. 2-50)
1-3Requisite Tasks Before Printing or Managing the Printing Operation
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■ Performing the Protocol Settings for the Printer
* Specify the protocol settings as needed.

There are three kinds of methods to perform the protocol settings, and the specifiable options vary depending on 
the application.

Installing the Printer Driver
The printer driver is software required for printing from an application you use. 
There are the following two ways to install the printer driver. The procedures for 
setting the IP address or creating a port required to print in a network environment 
vary depending on the installation method.

■ Installing the CAPT Software from CD-ROM Setup (See p. 2-2)
If you install the printer driver from the CD-ROM (CD-ROM Setup) supplied with the 
printer, you can easily configure the printer to print in a network environment by setting 
the IP address and creating a port at once.

■ Installing the Printer Driver Manually Using Various Utility Software (See p. 
2-29)
Specify the IP address or create a port (Canon CAPT Port) using the software in the 
CD-ROM ("NetSpot Device Installer" or "Print Monitor Installer") supplied with the network 
board, the ARP/PING command or others, and then install the printer driver from the 
[Printers and Faxes] folder or the [Printers] folder.

Performing the Protocol Settings for the Printer
After installing the printer driver, perform the protocol settings for the printer as 
needed. You can perform the protocol settings from the computer you are using, 
using any one of the following software.

■ Protocol Settings Using the Remote UI (See p. 2-84)
Perform the protocol settings by accessing the printer from your web browser via the 
network. 

■ Protocol Settings Using NetSpot Device Installer (See p. 2-92)
Perform the basic protocol settings by starting NetSpot Device Installer from the CD-ROM 
supplied with the network board or the one installed.When configuring the DNS server 
etc., use the Remote UI or FTP Client.

■ Protocol Settings Using FTP Client (See p. 2-98)
Perform the protocol settings by accessing the FTP server in the network board using 
Command Prompt (MS-DOS Prompt for Windows 98/Me).

Protocol Settings

Protocol Settings Using 
the Remote UI (See p. 

2-84)

Protocol Settings Using 
NetSpot Device Installer 

(See p. 2-92)

Protocol Settings Using 
FTP Client (See p. 2-98)
1-4 Requisite Tasks Before Printing or Managing the Printing Operation
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Managing the Printer in the Network Environment
You can perform the printer management, such as checking the printer status and 
specifying various settings, in a network environment using the following software. 
The specifiable options vary depending on the software. See "Network Setting 
Items" (p. 5-2), and use software appropriate to the network environment you are 
using or options that you want to specify.

■ Remote UI (See p. 3-3)
The Remote UI is software that allows you to manage the printer using a web browser. By 
accessing the printer from the web browser via a network, you can check the printer 
status or job history, and configure the network or security settings.

■ NetSpot Device Installer (See p. 3-34)
NetSpot Device Installer is software included in the CD-ROM supplied with the network 
board. Without installing it, you can run NetSpot Device Installer from the CD-ROM and 
specify the settings for the protocols or device information.

■ FTP Client (See p. 3-31)
FTP Client allows you to specify the settings for various information about the device and 
configure the network and security by accessing the FTP server on the network board 
using Command Prompt (MS-DOS Prompt for Windows 98/Me).
1-5Requisite Tasks Before Printing or Managing the Printing Operation
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System Requirements
Printer Driver
The following system environment is required to use the printer driver:

■ Operating system software
• Microsoft Windows 98
• Microsoft Windows Me
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition*
• Microsoft Windows Server 2003*
* 32-bit processor version only

IMPORTANT
For details on the minimum-required and recommended system requirements, see 
"User's Guide".

■ Interface
• Connector: 10BASE-T or 100BASE-TX
• Protocol: TCP/IP

NOTE
• When using Sound, a PC synthesizer (and the driver for PCM synthesizer) must be 

installed in your computer. Do not use a PC Speaker driver (speaker.drv etc.).
• If you are using LBP5100 with Windows 2000/XP/Server 2003 and specify Standard 

TCP/IP Port, Raw is specified as the print application to be used. The printer does not 
support LPR.

Canon CAPT Print Monitor
The following system environment is required to use Canon CAPT Print Monitor.

■ Operating system software
• Microsoft Windows 98
• Microsoft Windows Me
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition*
• Microsoft Windows Server 2003*
* 32-bit processor version only
1-6 System Requirements
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- System Requirements (minimum required)

(PC/AT Compatibles)

* As the amount of available memory varies depending on the system configuration of the computer or application 
you are using, the above environment does not guarantee printing in all cases.

- System Requirements (recommended)

■ Protocol
• TCP/IP

Remote UI
The following system environment is required to use the Remote UI:

■ Web Browser
• Netscape Navigator 4.7 or later
• Internet Explorer 4.01SP1 or later

■ Operating System
• An operating system on which the above web browser can run

■ Display
• Resolution: 800 x 600 pixels or more
• Display colors: 256 or more

NOTE
Software other than the above one, such as a web server, is not required. (A web server 
is preinstalled in the printer.)

Windows 98/Me Windows 2000/XP/Server 2003

CPU
Pentium II
300 MHz or more

Pentium II
300 MHz or more

Memory (RAM)* 64 MB or more 128 MB or more

Hard Disk 20 MB or more 20 MB or more

Windows 98/Me Windows 2000/XP/Server 2003

CPU
Pentium III
600 MHz or more

Pentium III
600 MHz or more

Memory (RAM) 128 MB or more 256 MB or more
1-7System Requirements
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NetSpot Device Installer
The following system environment is required to use NetSpot Device Installer:

■ Operating system software
• Microsoft Windows 98 + Service Pack 1 or later
• Microsoft Windows 98 Second Edition
• Microsoft Windows Me
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition
• Windows Server 2003

■ Computer
• A computer in which the above operating system can run

■ Hard Disk
• Free disk space of 15 MB or more (When the software is to be installed on the computer)

■ Protocol
• TCP/IP

■ Protocol Stack
• The TCP/IP protocol supplied with Windows
1-8 System Requirements
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Installing the CAPT Software
Install the printer driver on the computer you are using. The printer driver is 
software required for printing from an application you use. There are the following 
two ways to install the printer driver. The procedures for setting the IP address or 
creating a port required to print in a network environment vary depending on the 
installation method.

■ Installing the CAPT Software from CD-ROM Setup (See p. 2-2)
If you install the printer driver from the CD-ROM (CD-ROM Setup) supplied with the 
printer, you can easily configure the printer to print in a network environment by setting 
the IP address and creating a port at once.

■ Installing the Printer Driver Manually Using Various Utility Software (See p. 
2-29)
Specify the IP address or create a port (Canon CAPT Port) using the software in the 
CD-ROM ("NetSpot Device Installer" or "Print Monitor Installer") supplied with the network 
board, the ARP/PING command or others, and then install the printer driver from the 
[Printers and Faxes] folder or the [Printers] folder.

IMPORTANT
The printer driver is required for printing with the printer. Be sure to install the printer 
driver.

NOTE
For procedures for installing the CAPT software by connecting the printer and computer 
with a USB cable or by sharing the printer on a network, see "User's Guide".

Installing the CAPT Software from CD-ROM Setup
This section describes the procedure for installing the printer driver from the 
CD-ROM (CD-ROM Setup) supplied with the printer. If you install the printer driver 
from the CD-ROM, you can easily configure the printer to print in a network 
environment by setting the IP address and creating a port at once.

The installation procedure varies depending on the model you are using.

• For LBP5100 (See p. 2-3)

• For LBP5000, LBP3500, or LBP3300 (See p. 2-16)
2-2 Installing the CAPT Software
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IMPORTANT
When there is not enough free hard disk space, a message will appear during the 
installation. Stop the installation and increase the free space, and then install the CAPT 
software again.

NOTE
If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall, and the Windows Firewall is enabled, and if you want to detect the 
printer in which the IP address has not been set yet, unblock Windows Firewall to detect 
the printer during the installation process. If you do not want to unblock Windows 
Firewall, see "Installing the Printer Driver Manually Using Various Utility Software" (p. 
2-29) and specify the IP address for the printer in advance.

For LBP5100
If you are using LBP5000, LBP3500, or LBP3300, see "For LBP5000, LBP3500, or 
LBP3300," on p. 2-16.

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Turn the computer on and start up Windows.

NOTE
If you are using Windows 2000/XP/Server 2003, be sure to log on as a member of 
Administrators when starting up.

4 Insert the CD-ROM supplied with the printer into the CD-ROM 
drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

NOTE
If CD-ROM Setup does not appear, select [Run] from the [Start] menu, enter 
"D:\English\MInst.exe", and then click [OK]. (The CD-ROM drive name is indicated 
as "D:" in this manual. The CD-ROM drive name may differ depending on the 
computer you are using.)
2-3Installing the CAPT Software
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5 Click [Easy Installation] or [Custom Installation].

[Easy Installation] allows you to install the printer driver and the instruction 
manuals simultaneously. If you do not install the manuals, select [Custom 
Installation].

6 Click [Install].
Installing the CAPT Software2-4
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If you selected [Custom Installation] in Step 5, clear the [Online Manuals] check 
box, and then click [Install].

7 Confirm the contents, then click [Yes].

8 Click [Next].
2-5Installing the CAPT Software
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9 Select [Search for Network Printers to Install], then click 
[Next].

The TCP/IP port on the network is searched, and the printer is detected 
automatically.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, the 
following screen is displayed.

If the IP address of the printer has been already set, click [No].
If you want to clear the block and detect the printers in which the IP address has 
not been set yet, click [Yes].

10 Operation procedure varies depending on the content 
displayed in [Product Name] in [Printer List].
• When the name of the printer is displayed in [Product Name] (See p. 2-7)
• When [Unknown Device] is displayed in [Product Name] (See p. 2-7)

NOTE
If the printer to be installed is not displayed in [Printer List], perform the following 
settings:
- Make sure that the computer and printer are connected via the network and that 

the printer is ON.
- Click [Auto Search Again]. The printers on the network are searched for again.
- Click [Manual Search by IP Address]. By entering the IP address of the printer to 

be installed in the displayed [Manual Search by IP Address] dialog box and 
clicking [OK], the printer that has the entered IP address is searched for (Enter 
the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD).
Installing the CAPT Software2-6



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

● When the name of the printer is displayed in [Product Name]

❑ Select the printer to be installed, then click [Add].

NOTE
Depending on the system environment, "192.168.0.215" (the default value for the 
network board) is displayed in [IP Address] under [Printer List]. If you want to 
change the IP address, see "Protocol Settings for the Printer" (p. 2-84) to change 
the IP address after finishing the installation.
If you changed the IP address after installing the printer driver, see "Changing the 
Port" (p. 5-18) and set the port anew.

● When [Unknown Device] is displayed in [Product Name]

❑ Select the printer displayed as [Unknown Device], then click [Set IP Address].
2-7Installing the CAPT Software
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NOTE
If more than one [Unknown Device] are displayed, turn off the devices other than 
the printer to be installed or remove the devices from the network, and then click 
[Auto Search Again]. After completing the settings for the printer, restore the 
devices to their original states.

❑ Enter the IP address of the printer in the [Set IP Address] dialog box, then click 
[OK].

[Get automatically]: Obtain an IP address using DHCP (The DHCP server 
needs to be started up). For more details on configuring the DHCP server, ask 
your network administrator.
[Use the following IP address]: Specify the IP address directly (Enter the IP 
address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD).

❑ Select the printer to be installed, then click [Add].

11 Make sure that the name of the printer is added to [Printer List 
for Driver Installation].

NOTE
This procedure allows you to specify the settings for the printer information such as 
the printer sharing settings. You can also specify these settings in the [Printers and 
Faxes] folder or the [Printers] folder after the installation.
Installing the CAPT Software2-8
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● When you do not specify the settings for the printer information 
such as the printer sharing settings

❑ Click [Next].

If you are using Windows 2000/XP/Server 2003, the port is created as 
Standard TCP/IP Port, and if you are using Windows 98/Me, the port is created 
as Canon CAPT Port.

● When you specify the settings for the printer information such as 
the printer sharing settings

❑ Select the [Set Printer Information] check box, then click [Next].
2-9Installing the CAPT Software
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❑ Specify the settings for the printer information.

Options to be specified

❑ If you select the [Use as Shared Printer] check box, and if there is any 
computer on which Windows 98/Me runs on the network, click [Drivers to Add], 
select [Windows 98/Millennium Edition], and then click [OK].

[Printer Name]: Enter a new name in [Printer Name] if you want to 
change the printer name.

[Set as Default]: When using the printer as the default printer, select the 
[Set as Default] check box.

[Use as Shared Printer]: When the computer on which you are currently installing 
the printer driver is to be used as a print server, select 
the [Use as Shared Printer] check box. Change [Shared 
Name] as needed.
Installing the CAPT Software2-10
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❑ Click [Next].

If you are using Windows 2000/XP/Server 2003, Standard TCP/IP Port is 
created, and if you are using Windows 98/Me, Canon CAPT Port is created.

12 Click [Start].

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, the following screen is displayed. Specify 
whether to configure Windows Firewall to unblock communication with the client 
computers when sharing the printer on a network.
Click [Yes] when you share the printer on a network. After completing the 
installation, see "User's Guide" and specify the settings for sharing the printer on 
the network.
Click [No] when you do not share the printer on the network.
2-11Installing the CAPT Software
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NOTE
• Even after the installation, you can change the Firewall settings using "CAPT 

Windows Firewall Utility" in the CD-ROM supplied with the printer. For more details, 
see "User's Guide".

• The port name is specified automatically.

13 The message <Installation cannot be stopped once it starts. 
Do you want to continue?> appears. Click [Yes].

Installation of the printer driver starts.

NOTE
• Depending on the system environment, the installation may take a long time.
• If you are using Windows 2000 and the [Digital Signature Not Found] dialog box 

appears, click [Yes].
• If you are using Windows XP/Server 2003 and the [Hardware Installation] dialog 

box appears, click [Continue Anyway].

14 If [Easy Installation] is selected in Step 5, the manuals are 
installed.
Installing the CAPT Software2-12
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15 Confirm the installation results, then click [Next].

NOTE
If the printer driver installation does not finish successfully, see "Installation 
Problems," on p. 4-2.

16 Select the [Restart Computer Now (Recommended)] check 
box, then click [Restart].

Windows restarts.

Now, the installation of the printer driver is completed, and you can print from the 
computer. See "After Completing Installation" (p. 2-79) and make sure that the 
printer driver is installed properly. For details on the network settings, such as the 
settings for DNS and WINS, see "Protocol Settings for the Printer," on p. 2-84.
2-13Installing the CAPT Software
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17 If you are using Windows XP Service Pack 2 or another 
operating system equipped with Windows Firewall, it is 
recommended that you see the following procedure and 
specify the settings so that the port is opened through 
Windows Firewall.

You can print without specifying the settings, however, it may take a long time to 
obtain the status in the Printer Status Window.

18 From the [Start] menu, select [Control Panel].

19 Click [Network and Internet Connections], then click 
[Windows Firewall].

20 In the [Exceptions] sheet in the [Windows Firewall] dialog box, 
click [Add Port].
Installing the CAPT Software2-14
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21 Enter "CANON CAPT Port" in [Name].

22 Enter "3756" in [Port number].

23 Select [UDP], then click [OK].
2-15Installing the CAPT Software
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24 Make sure that "CANON CAPT Port" is added to [Programs 
and Services], and then click [OK].

For LBP5000, LBP3500, or LBP3300
If you are using LBP5100, see "For LBP5100," on p. 2-3.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5000 is being used.

1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Turn the computer on and start up Windows.

NOTE
If you are using Windows 2000/XP/Server 2003, be sure to log on as a member of 
Administrators when starting up.
Installing the CAPT Software2-16
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4 Insert the CD-ROM supplied with the printer into the CD-ROM 
drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
If CD-ROM Setup does not appear, select [Run] from the [Start] menu, enter 
"D:\English\MInst.exe", and then click [OK]. (The CD-ROM drive name is indicated 
as "D:" in this manual. The CD-ROM drive name may differ depending on the 
computer you are using.)

5 Click [Easy Installation] or [Custom Installation].

[Easy Installation] allows you to install the printer driver and the instruction 
manuals simultaneously. If you do not install the manuals, select [Custom 
Installation].

6 Click [Install].
2-17Installing the CAPT Software
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If you selected [Custom Installation] in Step 5, clear the [Online Manuals] check 
box, and then click [Install].

7 Click [Next].

8 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].
Installing the CAPT Software2-18
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9 Select [Search for Network Port to Install], then click [Next].

10 Click [Add/Delete].

The TCP/IP port on the network is searched, and the printer is detected 
automatically.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, the 
following screen is displayed.

If the IP address of the printer has been already set, click [No].
If you want to clear the block and detect the printers in which the IP address has 
not been set yet, click [Yes].
2-19Installing the CAPT Software
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11 Operation procedure varies depending on the content 
displayed in [Device Name] in [Printer List].
• When the name of the printer is displayed in [Device Name] (See p. 2-20)
• When [Unknown Device] is displayed in [Device Name] (See p. 2-21)

NOTE
If the printer to be installed is not displayed in [Printer List], perform the following 
settings:
- Make sure that the computer and printer are connected via the network and that 

the printer is ON.
- Click [Auto Search Again]. The printers on the network are searched for again.
- Click [Manual Search by IP Address]. By entering the IP address of the printer to 

be installed in the displayed [Manual Search by IP Address] dialog box and 
clicking [OK], the printer that has the entered IP address is searched for (Enter 
the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD).

● When the name of the printer is displayed in [Device Name]

❑ Select the printer to be installed, then click [Add to the Printer List for Driver 
Installation].

NOTE
Depending on the system environment, "192.168.0.215" (the default value for the 
network board) is displayed in [IP Address] under [Printer List]. If you want to 
change the IP address, see "Protocol Settings for the Printer" (p. 2-84) to change 
the IP address after finishing the installation. 
If you changed the IP address after installing the printer driver, see "Changing the 
Port" (p. 5-18) and set the port anew.
Installing the CAPT Software2-20
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● When [Unknown Device] is displayed in [Device Name]

❑ Select the printer displayed as [Unknown Device], then click [Set IP Address].

NOTE
If more than one [Unknown Device] are displayed, turn off the devices other than 
the printer to be installed or remove the devices from the network, and then click 
[Auto Search Again]. After completing the settings for the printer, restore the 
devices to their original states.

❑ Enter the IP address of the printer in the [Set IP Address] dialog box, then click 
[OK].

[Get automatically]: Obtain an IP address using DHCP (The DHCP server 
needs to be started up). For more details on configuring the DHCP server, ask 
your network administrator.
[Use the following IP address]: Specify the IP address directly (Enter the IP 
address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD).
2-21Installing the CAPT Software
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❑ Select the printer to be installed, then click [Add to the Printer List for Driver 
Installation].

12 Click [OK].

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, click 
[Yes] when the following screen is displayed.

A port (Canon CAPT Port) is created automatically.
Installing the CAPT Software2-22
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13 Make sure that the name of the printer is added to [Printer List 
for Driver Installation].

NOTE
This procedure allows you to specify the settings for the printer information such as 
the printer sharing settings. You can also specify these settings in the [Printers and 
Faxes] folder or the [Printers] folder after the installation.

● When you do not specify the settings for the printer information 
such as the printer sharing settings

❑ Click [Next].

● When you specify the settings for the printer information such as 
the printer sharing settings

❑ Select the [Set Printer Information] check box, then click [Next].
2-23Installing the CAPT Software
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❑ Specify the settings for the printer information.

Options to be specified

❑ If you have selected the [Use as Shared Printer] check box, click [Details], and 
then specify the detailed settings for the shared printer. Change the share 
name as needed. If there is any computer on which Windows 98/Me runs on 
the network, select [Intel Windows 98/Me], then click [OK].

[Printer Name]: Enter a new name in [Printer Name] if you want to 
change the printer name.

[Use as Shared Printer]: When the computer on which you are currently installing 
the printer driver is to be used as a print server, select 
the [Use as Shared Printer] check box.

[Set as Default]: When using the printer as the default printer, select the 
[Set as Default] check box.
Installing the CAPT Software2-24
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❑ Click [Next].

14 Click [Start].

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, the following screen is displayed. Specify 
whether to configure Windows Firewall to unblock communication with the client 
computers when sharing the printer on a network.
Click [Yes] when you share the printer on the network. After completing the 
installation, see "User's Guide" and specify the settings for sharing the printer on 
the network.
Click [No] when you do not share the printer on the network.

NOTE
• Even after the installation, you can change the Firewall settings using "CAPT 

Windows Firewall Utility" in the CD-ROM supplied with the printer. For more details, 
see "User's Guide".

• The port name is specified automatically.
2-25Installing the CAPT Software
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15 The message <Installation cannot be stopped once it starts. 
Do you want to continue?> appears. Click [Yes].

Installation of the printer driver starts.

NOTE
• Depending on the system environment, the installation may take a long time.
• If you are using Windows 2000 and the [Digital Signature Not Found] dialog box 

appears, click [Yes].
• If you are using Windows XP/Server 2003 and the [Hardware Installation] dialog 

box appears, click [Continue Anyway].

16 The screen that informs you of the completion of the printer 
driver installation is displayed. Click [Exit].
Installing the CAPT Software2-26
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17 If [Easy Installation] is selected in Step 5, the manuals are 
installed.

18 Confirm the installation results, then click [Next].

NOTE
If the printer driver installation does not finish successfully, see "Installation 
Problems," on p. 4-2.
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19 Select the [Restart Computer Now (Recommended)] check 
box, then click [Restart].
• For LBP5000 and LBP3300

• For LBP3500

Windows restarts.

Now, the installation of the printer driver is completed, and you can print from the 
computer. See "After Completing Installation" (p. 2-79) and make sure that the printer 
driver is installed properly. For details on the network settings, such as the settings for 
DNS and WINS, see "Protocol Settings for the Printer," on p. 2-84.
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Installing the Printer Driver Manually Using Various Utility 
Software

This section describes the procedures for installing the printer driver manually 
using various utility software. Before installing the printer driver from the [Printers 
and Faxes] folder or the [Printers] folder, you need to set the IP address and create 
a port (Canon CAPT Port) in order to configure the environment in which the printer 
and computer you are using can correspond to each other as shown in the following 
figure. Install the printer driver after configuring the network environment, following 
the procedure described in the figure.

IP Address Setting

IP Address Setting Using 
NetSpot Device Installer 

(See p. 2-30)

IP Address Setting Using 
the ARP/PING Command 

(See p. 2-40)

* If you are using Windows XP 
Service Pack 2 or another 
operating system equipped 
with Windows Firewall, set the 
IP address using the ARP/
PING command.

IP Address Setting Using 
the Printer Status Window 

(See p. 2-42)

* You can set the IP address 
from the Printer Status 
Window if the printer driver 
has already been installed by 
the USB connection.

Creating a Port (Canon CAPT Port)

Installing Canon CAPT Print Monitor Using Print Monitor Installer (See p. 2-45)

If you are using LBP5100 with Windows 2000/XP/Server 2003, you can 
specify Standard TCP/IP Port also. If you specify Standard TCP/IP Port, you 
do not need to install Canon CAPT Print Monitor.

Installing the Printer Driver

Installing the Printer Driver from the [Printers and Faxes] Folder 
or the [Printers] Folder (See p. 2-50)
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NOTE
The MAC address is required to set the IP address using the ARP/PING command. The 
MAC address is indicated on the network board (A) as shown in the following figure.

* LBP5100 is taken as the example.

IP Address Setting Using NetSpot Device Installer

IMPORTANT
If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall, and the Windows Firewall is enabled, be careful of the following 
points.

1. It is recommended that you set the IP address using the ARP/PING command 
(See p. 2-40).

2. If you want to set the IP address using NetSpot Device Installer, you need to add 
"NetSpot Device Installer" to Windows Firewall in advance. Perform either of the 
following procedures.
- Adding "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows 

Firewall] dialog box (See Readme of NetSpot Device Installer)
- Installing NetSpot Device Installer (You can add it to Windows Firewall during the 

installation) (See p. 3-35)
Readme of NetSpot Device Installer is in [Readme_English.html] in the following 
folder in the CD-ROM supplied with the network board.
-\NetSpot_Device_Installer\Windows

NOTE
• The screen shots used in this section are from Windows XP Professional with which 

LBP5100 is being used.
• The screen shots of NetSpot Device Installer used in this manual may be different from 

those actually you see on the screen.
• This section describes the procedure for using NetSpot Device Installer without installing 

it. For details on the procedures for installing NetSpot Device Installer, see "Managing the 
Printer Using NetSpot Device Installer," on p. 3-34.

(A)
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1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Insert the CD-ROM supplied with the network board into the 
CD-ROM drive.

4 Open [My Computer], then select the CD-ROM drive.

5 Select [Open] from the [File] menu.
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6 Double-click the [NetSpot_Device_Installer] folder.

7 Double-click the [Windows] folder.
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8 Double-click [nsdi.exe].

The [License Agreement] dialog box is displayed.

9 Confirm the contents, then click [Yes].

NetSpot Device Installer runs, and the target printer search starts.
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10 Set the IP address.

Display screens of NetSpot Device Installer vary depending on the system 
environment. 
Perform the following procedure according to the contents displayed in the 
device list.

• When [Status] is set to [Not Configured], and the device of which [Device 
Name] is the MAC address of the network board is displayed on the device list 
(See p. 2-35)

• When any device in which the setting for [IP Address] is the default setting is 
displayed in the device list (See p. 2-37)

• When your case falls within neither of the above cases (See p. 2-39)

IMPORTANT
If you want to set the IP address using NetSpot Device Installer, you need to add 
"NetSpot Device Installer" to Windows Firewall in advance. Perform either of the 
following procedures.
- Exiting NetSpot Device Installer once, then adding "NetSpot Device Installer" to 

the [Exceptions] sheet in the [Windows Firewall] dialog box (See Readme of 
NetSpot Device Installer)

- Installing NetSpot Device Installer (You can add it to Windows Firewall during the 
installation) (See p. 3-35)

Readme of NetSpot Device Installer is in [Readme_English.html] in the following 
folder in the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows

NOTE
If the desired printer is not detected, select [Discover Devices] from the [View] 
menu, and then search for the printer again.
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● When [Status] is set to [Not Configured], and the device of which 
[Device Name] is the MAC address of the network board is displayed 
on the device list

❑ Select the device.

❑ Select [Initial Settings] from the [Device] menu.

NOTE
You can obtain the same result by right-clicking the selected device and selecting 
[Initial Settings] from the pop-up menu.
2-35Installing the CAPT Software



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

❑ Specify the following settings in the [Initial Settings] dialog box, then click 
[Next].

Options to be specified

❑ Specify the IP address.

Options to be specified

[Subnet]: When the computer on which NetSpot Device Installer is 
running is connected to multiple networks (when multiple 
network interface boards are installed), select the subnet to 
which the device to be configured belongs.

[Product Type]:Select [LBP + NB-XX] (XX varies depending on the network 
board).

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for 
[IP Address] is specified for the 
network board.

[DHCP]: Obtains an IP address using DHCP. 
(The DHCP server needs to be 
started up.)

[IP Address]: Enter the IP address of the network board.
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Options to be specified as needed

● When any device in which the setting for [IP Address] is the default 
setting is displayed in the device list

❑ Select the device.

[Subnet Mask]: Enter the subnet mask that is being used on the 
TCP/IP network.

[Gateway Address]: Enter the gateway address that is being used on 
the TCP/IP network.

[Broadcast Address]: Enter the broadcast address that is being used 
on the TCP/IP network.
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❑ Select [Protocol Settings] from the [Device] menu.

❑ Specify the IP address.
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Options to be specified

Options to be specified as needed

NOTE
• If [RARP] is selected, you cannot enter any value in [IP Address].
• If [BOOTP] or [DHCP] is selected, you cannot enter any value in [IP Address], 

[Subnet Mask], and [Gateway Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].

● When your case falls within neither of the above cases

❑ If the display of NetSpot Device Installer falls within neither of the above even 
when the network cable is connected properly and the printer is ON, there is a 
possibility that a device whose IP address is the same as the default IP 
address of the printer exists on the network. In this case, turn off the device 
that has the same IP address or remove the device from the network, and then 
perform the procedure from Step 1 (See p. 2-31) again. After completing the 
settings for the printer, restore the devices to their original states. If this method 
is not possible, set the IP address using the ARP/PING command. For details 
on the procedure for setting the IP address using the ARP/PING command, 
see "IP Address Setting Using the ARP/PING Command," on p. 2-40.

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network board.

[Auto Detect]: Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. (The 
RARP daemon needs to be started up.)

[BOOTP]: Obtains an IP address using BOOTP. (The 
BOOTP daemon needs to be started up.)

[DHCP]: Obtains an IP address using DHCP. (The 
DHCP server needs to be started up.)

[IP Address]: Enter the IP address of the network board.

[Subnet Mask]: Enter the subnet mask that is being used on the TCP/IP 
network.

[Gateway Address]: Enter the gateway address that is being used on the TCP/IP 
network.
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11 After completing the settings, click [OK].

12 When the message <The device has been reset.> appears, 
click [OK].

To perform a reset operation properly, wait for approximately 20 seconds or longer 
as is after clicking [OK].

After completing the reset, the settings are enabled.

If you want to create Canon CAPT Port, install Canon CAPT Print Monitor in the next 
step (See p. 2-45). 
If you are using LBP5100 with Windows 2000/XP/Server 2003, you can specify 
Standard TCP/IP Port also. If you want to specify Standard TCP/IP Port, install the 
printer driver in the next step (See p. 2-50).

IP Address Setting Using the ARP/PING Command

1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] ➞ 
[Accessories] ➞ [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] ➞ [MS-DOS Prompt].

4 Enter the following command, then press the [ENTER] key on 
your keyboard.

arp -s <IP Address> <MAC Address>
Installing the CAPT Software2-40



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

NOTE
The MAC address is indicated on the network board (A) as shown in the following 
figure.

* LBP5100 is taken as the example.

5 Enter the following command, then press the [ENTER] key on 
your keyboard.

The IP address is set on the network board.

NOTE
• l of "-l" is the letter "L" of the alphabet.
• The subnet mask and gateway address are set to [0.0.0.0].

IP Address: Specify the IP address to assign to the printer. Specify the address 
with four numbers (from 0 to 255) separated with a period (.).

MAC Address: Specify the MAC address of the printer. When entering the number, 
separate the number every two digits with a hyphen (-).

Input Example: arp  -s  192.168.0.215  00-00-85-05-70-31

ping <the IP Address> -l 479

IP Address: Specify the same IP address as the one used in Step 4.

Input Example: ping 192.168.0.215 -l 479

(A)
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6 Enter "exit", then press the [ENTER] key on your keyboard.

Exit Command Prompt or MS-DOS Prompt.

If you want to create Canon CAPT Port, install Canon CAPT Print Monitor in the next 
step (See p. 2-45). 
If you are using LBP5100 with Windows 2000/XP/Server 2003, you can specify 
Standard TCP/IP Port also. If you want to specify Standard TCP/IP Port, install the 
printer driver in the next step (See p. 2-50).

IP Address Setting Using the Printer Status Window
You can set the IP address from the Printer Status Window if the printer driver has 
already been installed by the USB connection.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] ➞ [Printers and Faxes].

2 Select the icon for your printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for your printer, then select [Properties] from 
the [File] menu.
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3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".

4 From the [Options] menu, select [Device Settings] ➞ [Network 
Settings].
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5 Specify the IP address.

Options to be specified

Options to be specified as needed

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network 
board.

[Auto 
Detect]:

Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. 
(The RARP daemon needs to be 
started up.)

[BOOTP]: Obtains an IP address using BOOTP. 
(The BOOTP daemon needs to be 
started up.)

[DHCP]: Obtains an IP address using DHCP. 
(The DHCP server needs to be started 
up.)

[IP Address]: Enter the IP address of the network board.

[Subnet Mask]: Enter the subnet mask that is being used on the 
TCP/IP network.

[Gateway Address]: Enter the gateway address that is being used on 
the TCP/IP network.

[Password]: Enter the administrator password for the network 
board. If the password has not been specified yet, it 
is not required to enter the password.
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NOTE
• If [RARP] is selected, you cannot enter any value in [IP Address].
• If [BOOTP] or [DHCP] is selected, you cannot enter any value in [IP Address], 

[Subnet Mask], and [Gateway Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].

6 After completing the settings, click [OK].

The Printer Status Window reappears.

If you want to create Canon CAPT Port, install Canon CAPT Print Monitor in the next 
step (See p. 2-45). 
If you are using LBP5100 with Windows 2000/XP/Server 2003, you can specify 
Standard TCP/IP Port also. If you want to specify Standard TCP/IP Port, install the 
printer driver in the next step (See p. 2-50).

Installing the Canon CAPT Print Monitor

NOTE
• If you are using LBP5100 with Windows 2000/XP/Server 2003, you can specify Standard 

TCP/IP Port also. If you specify Standard TCP/IP Port, you do not need to install Canon 
CAPT Print Monitor. Proceed to the installation of the printer driver. (See p. 2-50)

• The screen shots used in this section are from Windows XP Professional.

1 Insert the CD-ROM supplied with the network board into the 
CD-ROM drive.

To install Canon CAPT Print Monitor downloaded from the Canon website, 
decompress the downloaded file, double-click the created folder, and then 
proceed to Step 5.
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2 Open [My Computer], then select the CD-ROM drive.

3 Select [Open] from the [File] menu.
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4 Double-click the [Print_Monitor_Installer] folder.

5 Double-click the [English] folder.

6 Double-click [Setup.exe].

The installer of Canon CAPT Print Monitor starts.
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7 Click [Next].

8 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].
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If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and when the following screen appears, select 
[Yes], and then click [Next].

9 Click [Start].

Installation of Canon CAPT Print Monitor starts.
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10 Restart the computer following the instructions on the screen.

Next, install the printer driver (See p. 2-50).

Installing the Printer Driver from the [Printers and Faxes] Folder or 
the [Printers] Folder

■ For Windows XP/Server 2003

If you are using an operating system other than Windows XP/Server 2003, see the 
following.

• For Windows 2000 (See p. 2-61)

• For Windows 98/Me (See p. 2-70)

IMPORTANT
When printing a test page, make sure that the printer is properly connected to the 
computer and the printer is ON before installing the printer driver.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.
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1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Turn the computer on and start up Windows XP/Server 2003.

4 Log on as a member of Administrators.

NOTE
Full Control Permission is required for the installation of the printer driver.

5 Display the [Printers and Faxes] folder.

For Windows XP Professional/Server 2003
From the [Start] menu, select [Printers and Faxes].

For Windows XP Home Edition
From the [Start] menu, select [Control Panel], and then click [Printers and Other 
Hardware] ➞ [Printers and Faxes].

6 Click [Add a printer].

For Windows Server 2003: Double-click [Add Printer].
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7 Click [Next].

8 Make sure that [Local printer attached to this computer] is 
selected, then click [Next].

NOTE
Do not select the [Automatically detect and install my Plug and Play printer] check 
box.
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9 Select [Create a new port].

10 Create a port.
• When using Standard TCP/IP Port (only for LBP5100) (See p. 2-53)
• When using Canon CAPT Port (See p. 2-56)

● When specifying Standard TCP/IP Port (only for LBP5100)

❑ Select [Standard TCP/IP Port] from [Type of port], then click [Next].
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❑ Click [Next].

❑ Enter the IP address or name of the printer (the DNS name registered on the 
DNS server (up to 78 characters)) in [Printer Name or IP Address], and then 
click [Next].

Depending on the method for setting the IP address of the printer, the value to 
be entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) 
or ask your network administrator.
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IMPORTANT
If the following screen appears, search for the printer following the instructions on 
the screen, or from [Device Type] select [Standard] ➞ [Canon Network Printing 
Device with P9100], and then click [Next].

❑ After the computer has confirmed that there is a printer that has the IP address 
you entered, the [Completing the Add Standard TCP/IP Printer Port Wizard] 
window appears. Click [Finish].

NOTE
If you are using Windows XP Service Pack 2 or another operating system equipped 
with Windows Firewall and want to use Standard TCP/IP Port, it is recommended 
that you see the procedure from Step 18 of "Installing the CAPT Software from 
CD-ROM Setup" (p. 2-14) and specify the settings so that the port is opened 
through Windows Firewall. You can print without specifying the settings, however, it 
may take a long time to obtain the status in the Printer Status Window.
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● When specifying Canon CAPT Port

❑ Select [Canon CAPT Port] from [Type of port], then click [Next].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (See p. 2-45) again.

❑ From [Available network printers], select the port of the IP address specified 
using NetSpot Device Installer, the ARP/PING command, or the Printer Status 
Window, and then click [OK].

If the target printer's port name is not displayed in [Available network printers], 
click [Update Printer List]. If this does not display the target printer's port name, 
click [Add to List Manually], enter the IP address or printer name (the DNS 
name registered on the DNS server (up to 78 characters)) in [IP Address or 
Printer Name] in the [Add to List Manually] dialog box, and then click [OK]. 
Depending on the method for setting the IP address of the printer, the value to 
be entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) 
or ask your network administrator.
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11 Click [Have Disk].

12 Insert the CD-ROM supplied with the printer into the CD-ROM 
drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

13 Select [D:\English\Win2K_XP]. Select the INF file, then click 
[Open].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.
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14 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win2K_XP].

15 Click [Next].

16 Enter a new name in [Printer name] if you want to change the 
printer name, then click [Next].
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NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want to use this printer as the default printer?> appears. In this case, 
select [Yes] or [No].

17 Click [Next].

NOTE
When sharing the printer on a network, select [Share name], and then click [Next]. 
The window for entering [Location] and [Comment] is displayed. Enter them as 
needed, then click [Next].

18 When printing a test page, click [Yes], then click [Next].
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19 Click [Finish].

Copying files is started.

When printing a test page, a dialog box will appear after printing. Click [OK] to 
close the dialog box.

IMPORTANT
If you are using a computer with Windows XP Service Pack 2 or another operating 
system equipped with Windows Firewall as the print server, you need to configure 
Windows Firewall to unblock communication with the client computers. For details 
on configuring Windows Firewall to unblock communication, see "User's Guide".

NOTE
If the [Hardware Installation] dialog box appears, click [Continue Anyway].

Now, the installation of the printer driver is completed, and you can print from the 
computer. See "After Completing Installation" (p. 2-79) and make sure that the printer 
driver is installed properly. For details on the network settings, such as the settings for 
DNS and WINS, see "Protocol Settings for the Printer," on p. 2-84.
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■ For Windows 2000

If you are using an operating system other than Windows 2000, see the following.

• For Windows XP/Server 2003 (See p. 2-50)

• For Windows 98/Me (See p. 2-70)

IMPORTANT
When printing a test page, make sure that the printer is properly connected to the 
computer and the printer is ON before installing the printer driver.

NOTE
The screen shots used in this section are examples of when LBP5100 is being used.

1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 Turn the computer on and start up Windows 2000.

4 Log on as a member of Administrators.

NOTE
Full Control Permission is required for the installation of the printer driver.

5 From the [Start] menu, select [Settings] ➞ [Printers] to open 
the [Printers] folder. Then, double-click [Add Printer].

The [Add Printer Wizard] dialog box is displayed.
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6 Click [Next].

7 Make sure that [Local printer] is selected, then click [Next].

NOTE
Do not select the [Automatically detect and install my Plug and Play printer] check 
box.
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8 Select [Create a new port].

9 Create a port.
• When using Standard TCP/IP Port (only for LBP5100) (See p. 2-63)
• When using Canon CAPT Port (See p. 2-66)

● When specifying Standard TCP/IP Port (only for LBP5100)

❑ Select [Standard TCP/IP Port] from [Type], then click [Next].
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❑ Click [Next].

❑ Enter the IP address or name of the printer (the DNS name registered on the 
DNS server (up to 78 characters)) in [Printer Name or IP Address], and then 
click [Next].

Depending on the method for setting the IP address of the printer, the value to 
be entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) 
or ask your network administrator.
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IMPORTANT
If the message <Additional Port Information Required> appears on the screen, 
search for the printer following the instructions on the screen, or from [Device Type] 
select [Standard] ➞ [Canon Network Printing Device with P9100], and then click 
[Next].

❑ After the computer has confirmed that there is a printer that has the IP address 
you entered, the [Completing the Add Standard TCP/IP Printer Port Wizard] 
window appears. Click [Finish].
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● When specifying Canon CAPT Port

❑ Select [Canon CAPT Port] from [Type], then click [Next].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (See p. 2-45) again.

❑ From [Available network printers], select the port of the IP address specified 
using NetSpot Device Installer, the ARP/PING command, or the Printer Status 
Window, and then click [OK].

If the target printer's port name is not displayed in [Available network printers], 
click [Update Printer List]. If this does not display the target printer's port 
name, click [Add to List Manually], enter the IP address or printer name (the 
DNS name registered on the DNS server (up to 78 characters)) in [IP Address 
or Printer Name] in the [Add to List Manually] dialog box, and then click [OK]. 
Depending on the method for setting the IP address of the printer, the value to 
be entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) 
or ask your network administrator.
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10 Click [Have Disk].

11 Insert the CD-ROM supplied with the printer into the CD-ROM 
drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

12 Select [D:\English\Win2K_XP]. Select the INF file, then click 
[Open].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.
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13 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win2K_XP].

14 Click [Next].

15 Enter a new name in [Printer name] if you want to change the 
printer name, then click [Next].
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NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want your Windows-based programs to use this printer as the default 
printer?> appears. In this case, select [Yes] or [No].

16 Click [Next].

NOTE
When sharing the printer on a network, select [Share as], and then click [Next]. The 
window for entering [Location] and [Comment] is displayed. Enter them as needed, 
then click [Next].

17 When printing a test page, click [Yes], then click [Next].
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18 Click [Finish].

Copying files is started.

When printing a test page, a dialog box will appear after printing. Click [OK] to 
close the dialog box.

NOTE
If the [Digital Signature Not Found] dialog box appears, click [Yes].

Now, the installation of the printer driver is completed, and you can print from the 
computer. See "After Completing Installation" (p. 2-79) and make sure that the printer 
driver is installed properly. For details on the network settings, such as the settings for 
DNS and WINS, see "Protocol Settings for the Printer," on p. 2-84.

■ For Windows 98/Me

If you are using an operating system other than Windows 98/Me, see the following.

• For Windows XP/Server 2003 (See p. 2-50)

• For Windows 2000 (See p. 2-61)

NOTE
The screen shots used in this section are from Windows Me with which LBP5100 is being 
used.
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1 Make sure that the computer and printer are connected via the 
network.

2 Make sure that the printer is ON.

3 From the [Start] menu, select [Settings] ➞ [Printers] to open 
the [Printers] folder. Then, double-click [Add Printer].

The [Add Printer Wizard] dialog box is displayed.

NOTE
The [Add Printer Wizard] dialog box can also be displayed using the following 
procedure:
- Double-click [My Computer] ➞ [Control Panel] ➞ [Printers] ➞ [Add Printer] (For 

Windows Me).
- Double-click [My Computer] ➞ [Printers] ➞ [Add Printer] (For Windows 98).

4 Click [Next].

5 Select [Local printer], then click [Next].
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NOTE
This screen does not appear when the network settings have not been configured.

6 Click [Have Disk].

7 Insert the CD-ROM supplied with the printer into the CD-ROM 
drive, and then click [Browse].

If CD-ROM Setup appears, click [Exit].

8 Select [D:\English\Win98_Me], then click [OK].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.
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9 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win98_Me].

10 Select the name of the printer for [Printers], then click [Next].

11 Select [LPT1], then click [Next].

NOTE
Do not select [Canon CAPT Port] at this point.
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12 Enter a new name in [Printer name] if you want to change the 
printer name.

NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want your Windows-based programs to use this printer as the default 
printer?> appears. In this case, select [Yes] or [No].

13 Click [Finish].

Copying files is started.

14 When the dialog box for completing the installation appears, 
click [OK].

15 From the [Start] menu, select [Settings] ➞ [Printers].

16 Select the icon for the printer you are using.
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17 Select [Properties] from the [File] menu.

18 Display the [Details] sheet.
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19 Select [Canon CAPT Port] from [Print to the following port], 
and then proceed to Step 23.

If [Canon CAPT Port] is not displayed in [Print to the following port], perform the 
following procedure. 

20 Click [Add Port].
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21 Select [Other], select [Canon CAPT Port], and then click [OK].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (p. 2-45) again.

22 From [Available network printers], select the port of the IP 
address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click 
[OK].

If the target printer's port name is not displayed in [Available network printers], 
click [Update Printer List]. If this does not display the target printer's port name, 
click [Add to List Manually], enter the IP address or printer name (the DNS name 
registered on the DNS server (up to 78 characters)) in [IP Address or Printer 
Name] in the [Add to List Manually] dialog box, and then click [OK]. Depending 
on the method for setting the IP address of the network board, the value to be 
entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) or ask 
your network administrator.
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23 Click [OK].

Now, the installation of the printer driver is completed, and you can print from the 
computer. See "After Completing Installation" (p. 2-79) and make sure that the printer 
driver is installed properly. For details on the network settings, such as the settings for 
DNS and WINS, see "Protocol Settings for the Printer," on p. 2-84.
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When the installation of the CAPT software is completed, an icon and folder for the 
printer will be created.

For Windows XP/Server 2003

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

• The icon for the printer is displayed in the [Printers and Faxes] folder.

• [Canon Printer Uninstaller] is added to [All Programs] under the [Start] menu.

• If the manuals are installed, [LBPxxxx Online Manuals] is created on the desktop. (xxxx 
varies depending on the printer.)

Depending on the model you are using, [LBPxxxx Online Manuals] under [Canon LBPxxxx] is 
added to [All Programs] under the [Start] menu. (xxxx varies depending on the printer.)
2-79After Completing Installation



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

For Windows 98/Me/2000

NOTE
The screen shots used in this section are from Windows 2000 with which LBP5100 is 
being used.

• The icon for the printer is displayed in the [Printers] folder.

• [Canon Printer Uninstaller] is added to [Programs] under the [Start] menu.

• If the manuals are installed, [LBPxxxx Online Manuals] is created on the desktop. (xxxx 
varies depending on the printer.)

Depending on the model you are using, [LBPxxxx Online Manuals] under [Canon 
LBPxxxx] is added to [Programs] under the [Start] menu. (xxxx varies depending on the 
printer.)
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Before using the printer for the first time, be sure to perform Network Status Print to 
check the operations using the following procedure. Network Status Print prints the 
version of the optional network board or the TCP/IP settings.

NOTE
• Network Status Print is designed to be printed on A4 size paper. Load A4 size paper.
• The screen shots used in this section are from Windows XP Professional with which 

LBP5100 is being used.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] ➞ [Printers and Faxes].

2 Select the icon for your printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for your printer, then select [Properties] from 
the [File] menu.
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3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".

4 From the [Options] menu, select [Utility] ➞ [Network Status 
Print].
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5 Click [OK].

Network Status Print is printed.

IMPORTANT
This is a sample of Network Status Print. The contents may differ from the Network 
Status Print printed by your printer.

NOTE
If the Network Status Print is not printed properly, see "Chapter 4 Troubleshooting".
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Protocol Settings for the Printer
After installing the printer driver, perform the protocol settings for the printer as 
needed. You can perform the protocol settings from the computer you are using, 
using any one of the following software.

■ Protocol Settings Using the Remote UI (See p. 2-84)
Perform the protocol settings by accessing the printer from your web browser via the 
network.

■ Protocol Settings Using NetSpot Device Installer (See p. 2-92)
Perform the basic protocol settings by starting NetSpot Device Installer from the CD-ROM 
supplied with the network board or the one installed. When configuring the DNS server 
etc., use the Remote UI or FTP Client.

■ Protocol Settings Using FTP Client (See p. 2-98)
Perform the protocol settings by accessing the FTP server in the network board using 
Command Prompt (MS-DOS Prompt for Windows 98/Me).

 

Protocol Settings Using the Remote UI

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

IMPORTANT
• If you are not sure about the IP address of the printer, refer to the Network Status 

Print printed in "Checking the Operations with Network Status Print" (p. 2-81) or 
ask your network administrator.

• Use Netscape Navigator/Communicator 4.7 or later or Internet Explorer 4.01SP1 
or later as the web browser.
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• You cannot connect the computer to the printer via a proxy server. If you are using 
a proxy server, perform the following settings. (The setting varies depending on the 
network environment.)
- On the settings for the proxy server of the web browser, add the IP address of the 

printer to [Exceptions] (The addresses that do not use the proxy server).
• Configure the web browser so that you can use Cookie.
• If multiple Remote UIs are running simultaneously, the latest setting is effective. It 

is recommended that only one Remote UI should be running at a time.

NOTE
Depending on the system environment, the screen for the Remote UI is not 
displayed. In this case, enter "http://<the IP address of the printer>/cab/top.shtml" 
in [Address] or [Location] to redisplay the screen.

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Network] from the [Device Manager] menu.
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4 Click [Change] under [TCP/IP].

5 Specify [IP Address], [Subnet Mask], and [Gateway Address].

Enter the IP address of the printer in [IP Address]. Enter the addresses used in 
the TCP/IP network in [Subnet Mask] and [Gateway Address].

NOTE
• Even if you are using any one of DHCP, BOOTP, or RARP, specify [IP Address], 

[Subnet Mask], and [Gateway Address]. If you cannot obtain information from the 
servers of DHCP, BOOTP, and RARP, the values specified here are used.

• If you specify to use any one of DHCP, BOOTP, or RARP, the values obtained from 
those are displayed after resetting the network board (If the values have been 
specified previously, they overwrite the obtained ones).

• You may need to set the port anew if you changed the IP address or the method for 
obtaining the IP address after installing the printer driver. To set the port anew, see 
"Changing the Port," on p. 5-18.
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6 Perform the settings described in the following procedure as 
needed. If you do not perform the settings, proceed to Step 
12.

7 Specify the method for setting the IP address of the printer. 
Among [DHCP], [BOOTP], and [RARP], set any option that you 
want to use for the IP address setting to [On].

As well as by assigning the IP address directly, you can set the IP address by 
using any one of DHCP, BOOTP, or RARP. When restarting or resetting the printer, 
whether DHCP, BOOTP, and RARP are available is checked, and the IP address 
is assigned by the method that is determined to be available the soonest. If you 
set [DHCP], [BOOTP], or [RARP] to [Off], the corresponding protocol is not 
checked.
If you can use none of these, assign the IP address specified in [IP Address].

IMPORTANT
For details on the procedure for performing the port setting when setting the IP 
address using any one of DHCP, BOOTP, or RARP, see "Settings for Adding a Port" 
(p. 5-16) or ask your network administrator.

NOTE
• Because it takes one to two minutes to check whether DHCP, BOOTP, and RARP 

are available, it is recommended that you set the unused protocol(s) to [Off].
• To assign the IP address using DHCP, BOOTP, or RARP, the DHCP server, BOOTP 

daemon, or RARP daemon needs to be started up.
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8 Specify the settings for [DNS Settings].

❑ Enter the IP address of the DNS server in [DNS Server Address].

❑ When using the DNS Dynamic Update function, set [DNS Dynamic Update] to 
[On].

❑ Specify the host name to be added to the DNS server in [DNS Host Name].

❑ Enter the name of the domain to which the printer belongs in [DNS Domain 
Name].

Input Example : example.com

IMPORTANT
• DNS Dynamic Update is a function that adds the IP address of the device and the 

names specified as the host name and domain name to the DNS server 
automatically. This function can be used in the environment in which a Dynamic 
DNS server is being used.

• To use the DNS Dynamic Update function, you need to specify the IP address, host 
name, and domain name of the DNS server.

• For details on the procedure for performing the port setting when using the DNS 
server, see  "Settings for Adding a Port" (p. 5-16) or ask your network administrator.

NOTE
DNS is used when performing name resolution using the SNTP server name 
(When you specify the SNTP server name in Step 10).
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9 Specify the settings for [WINS Settings].

● When using WINS Resolution

❑ Set [WINS Resolution] to [On].

❑ Enter the IP address of the WINS server in [WINS Server Address].

❑ Enter the host name to be added to the WINS server in [WINS Host Name].

❑ In [Scope ID], enter the Scope ID of the NetBIOS name that you want to search 
for from the WINS server.

You can refine the search by separating the character string with periods (.).

● When not using WINS Resolution

❑ Set [WINS Resolution] to [Off].

10 Specify [SNTP] when using SNTP Client to obtain the time.

● If you have specified the settings for DNS in Step 8

❑ Enter the server name of the SNTP server in [SNTP Server Name].

❑ Select [Time Zone].

❑ To set daylight saving time, set [Daylight Saving Time] to [On].
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● If you have not specified the settings for DNS in Step 8

❑ Enter the IP address of the SNTP server in [SNTP Server Name].

❑ Select [Time Zone].

❑ To set daylight saving time, set [Daylight Saving Time] to [On].

NOTE
• When you cannot use the SNTP server function, you can report the time set on the 

computer to the printer using the following procedure. For details on the Printer 
Status Window, see "User's Guide".

1. Display the Printer Status Window.
2. Select [Preferences] from the [Options] menu.
3. Set [Monitor Printer Status] in the [Preferences] dialog box to [Always], and 

then select the [Notify the Printer of the Time] check box.
• Time Zone: The standard time zones of the world are expressed globally in terms 

of the difference in hours (± up to 12 hours) from GMT* (± 0 hours). A time zone is 
a region throughout which this time difference is the same.
*The time at the Greenwich Observatory in England is called GMT (Greenwich Mean Time).

• Daylight Saving Time: In some countries and regions, time is advanced throughout 
the summer season. The period in which this is applied is called "Daylight Saving 
Time."

11 Specify the settings for [Multicast Discovery Settings].

NOTE
Multicast discovery is a function that searches for certain devices using the service 
location protocol (SLP). By using the multicast discovery function, you can search 
for only the devices whose values in [Scope Name] are verified, using the service 
location protocol (SLP) from utility software, such as NetSpot Device Installer.

● When setting the printer so that it responds to searches that used 
the multicast discovery function

❑ Set [Response] to [On].
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❑ In [Scope Name], enter the name of the scope, used in cases as searching for 
a specific device through multicast from such utility software as NetSpot Device 
Installer.

● When setting the printer so that it does not response to searches 
that used the multicast discovery function

❑ Set [Response] to [Off].

12 Click [OK].

13 When the following screen is displayed, click [Reset] to reset 
the network board.

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).

The protocol settings for the printer are now completed.
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Protocol Settings Using NetSpot Device Installer
NetSpot Device Installer allows you to perform the basic protocol settings. When 
configuring the DNS server etc., use the Remote UI or FTP Client.

IMPORTANT
If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall, and the Windows Firewall is enabled, you cannot search for the 
printers on a subnet that is different from the one that the computers using NetSpot 
Device Installer are on. To search for such a printer, you need to add "NetSpot Device 
Installer" to Windows Firewall in advance. Perform either of the following procedures.
- Adding "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] 

dialog box (See Readme of NetSpot Device Installer)
- Installing NetSpot Device Installer (You can add it to Windows Firewall during the 

installation) (See p. 3-35)
Readme of NetSpot Device Installer is in [Readme_English.html] in the following folder in 
the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows

NOTE
• The screen shots used in this section are from Windows XP Professional with which 

LBP5100 is being used.
• The screen shots of NetSpot Device Installer used in this manual may be different from 

those actually you see on the screen.
• This section describes the procedure for running NetSpot Device Installer from the 

CD-ROM supplied with the network board. The procedure for running NetSpot Device 
Installer when it is installed on the computer is as follows. For details on the procedures 
for installing NetSpot Device Installer, see "Installing NetSpot Device Installer," on p. 
3-35.
- If NetSpot Device Installer is added to the [Start] menu on the installation

From the [Start] menu, select [Programs] ([All Programs] for Windows XP/Server 2003) 
➞ [NetSpot Device Installer] ➞ [NetSpot Device Installer].

- If NetSpot Device Installer is not added to the [Start] menu on the installation
Double-click [nsdi.exe] in the folder in which NetSpot Device Installer is installed.
Protocol Settings for the Printer2-92



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

1 Insert the CD-ROM supplied with the network board into the 
CD-ROM drive.

2 Open [My Computer], then select the CD-ROM drive.

3 Select [Open] from the [File] menu.
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4 Double-click the [NetSpot_Device_Installer] folder.

5 Double-click the [Windows] folder.
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6 Double-click [nsdi.exe].

If the [License Agreement] dialog box appears, click [Yes].

7 Select the printer.

IMPORTANT
If you are using Windows XP Service Pack 2 or another operating system equipped 
with Windows Firewall, and the Windows Firewall is enabled, you cannot search for 
the printers on a subnet that is different from the one that the computers using 
NetSpot Device Installer are on. To search for such a printer, you need to add 
"NetSpot Device Installer" to Windows Firewall in advance. Perform either of the 
following procedures.
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- Adding "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows 
Firewall] dialog box (See Readme of NetSpot Device Installer)

- Installing NetSpot Device Installer (You can add it to Windows Firewall during the 
installation) (See p. 3-35)

Readme of NetSpot Device Installer is in [Readme_English.html] in the following 
folder in the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows

8 Select [Protocol Settings] from the [Device] menu.

9 Perform the protocol settings.
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Options to be specified

Options to be specified as needed

NOTE
• If [RARP] is selected, you cannot enter any value in [IP Address].
• If [BOOTP] or [DHCP] is selected, you cannot enter any value in [IP Address], 

[Subnet Mask], and [Gateway Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].
• You may need to set the port anew if you changed the IP address or the method for 

obtaining the IP address after installing the printer driver. To set the port anew, see 
"Changing the Port," on p. 5-18.

10 After completing the settings, click [OK].

11 When the message <The device has been reset.> appears, 
click [OK].

To perform a reset operation properly, wait for approximately 20 seconds or longer 
as is after clicking [OK].

After completing the reset, the settings are enabled.

The protocol settings for the printer are now completed.

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network board.

[Auto Detect]: Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. (The 
RARP daemon needs to be started up.)

[BOOTP]: Obtains an IP address using BOOTP. (The 
BOOTP daemon needs to be started up.)

[DHCP]: Obtains an IP address using DHCP. (The 
DHCP server needs to be started up.)

[IP Address]: Enter the IP address of the network board.

[Subnet Mask]: Enter the subnet mask that is being used on the TCP/IP 
network.

[Gateway Address]: Enter the gateway address that is being used on the TCP/IP 
network.
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Protocol Settings Using FTP Client

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] ➞ 
[Accessories] ➞ [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] ➞ [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

Input Example : ftp 192.168.0.215

NOTE
If you are not sure about the IP address of the printer, refer to the Network Status 
Print printed in "Checking the Operations with Network Status Print" (p. 2-81) or 
ask your network administrator.

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

● If the password is specified for the printer

❑ Enter the password.

● If the password is not specified for the printer

❑ Do not enter the password, but press the [ENTER] key on your keyboard.

NOTE
You can log in by entering a name other than "root" (or leaving the field blank). In 
this case, you can perform operations other than settings.

4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.
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IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.

5 Using Notepad, etc., edit the downloaded config file.

For details on descriptions of each option, see "Network Setting Items," on p. 5-2.

NOTE
You may need to set the port anew if you changed the IP address or the method for 
obtaining the IP address after installing the printer driver. To set the port anew, see 
"Changing the Port," on p. 5-18.

6 Enter the following command, then press the [ENTER] key on 
your keyboard.

put  <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

7 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).

8 Enter "quit", then press the [ENTER] key on your keyboard.

9 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.

The protocol settings for the printer are now completed.
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Uninstalling the CAPT Software
The process of removing software to restore the computer to the same state as 
before the software was installed is referred to as uninstallation. The CAPT 
software can be uninstalled using the following procedure.

• Uninstalling the Printer Driver (See p. 2-100)

• Uninstalling Canon CAPT Print Monitor (See p. 2-102)

• Uninstalling NetSpot Device Installer (See p. 2-104)

IMPORTANT
• If the manuals have already been installed, you can also uninstall the installed manuals 

by uninstalling the printer driver with the Uninstaller.
• If the printer driver was installed on Windows 2000/XP/Server 2003 logged on by a user 

who is a member of Administrators, it cannot be uninstalled from the computer logged on 
by anyone other than users who are members of Administrators. Be sure to log in as a 
member of Administrators before the uninstallation.

• If the printer driver is installed, Canon CAPT Print Monitor cannot be uninstalled. 
Uninstall the printer driver before uninstalling Canon CAPT Print Monitor.

• If you are using a computer with Windows XP Service Pack 2 or another operating 
system equipped with Windows Firewall, your printer is registered in the [Exceptions] 
sheet in the [Windows Firewall] dialog box. When you uninstall the CAPT software using 
the uninstaller, the settings for the [Exceptions] sheet in the [Windows Firewall] dialog 
box are also removed.

Uninstalling the Printer Driver

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Close all of the files and programs listed below:
• Help files
• Printer Status Window
• Control Panel
• Other applications
2-100 Uninstalling the CAPT Software
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2 From the [Start] menu, select [All Programs] ➞ [Canon Printer 
Uninstaller] ➞ [Canon LBPxxxx Uninstaller]. (xxxx varies 
depending on the printer.)

For Windows 98/Me/2000: From the [Start] menu, select [Programs] ➞ [Canon 
Printer Uninstaller] ➞ [Canon LBPxxxx Uninstaller]. (xxxx varies depending on 
the printer.)

3 Select the name of the printer, then click [Delete].

NOTE
Even if the printer is not on the list in the [Delete Printer] dialog box, you can delete 
the file and information related to the printer by clicking [Delete].

4 Click [Yes].

If the printer is being used as a shared printer, the following screen appears. 
Confirm the contents of the message, and then click [Yes] if you want to uninstall 
the printer driver.

Uninstallation starts. Please wait a moment.
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5 Click [Exit].

NOTE
If the CAPT software cannot be uninstalled, see "When Uninstallation Fails," on p. 
4-5.

Uninstalling Canon CAPT Print Monitor

IMPORTANT
If the printer driver is installed, Canon CAPT Print Monitor cannot be uninstalled. 
Uninstall the printer driver before uninstalling Canon CAPT Print Monitor.

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Close all of the files and programs listed below:
• Help files
• Control Panel
• Other applications

2 From the [Start] menu, select [Control Panel], click [Add or 
Remove Programs], and then close [Control Panel].

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Control 
Panel], and then double-click [Add/Remove Programs].
For Windows Server 2003: From the [Start] menu, select [Control Panel] ➞ [Add 
or Remove Programs].
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3 Select [Canon CAPT Print Monitor] in the [Add or Remove 
Programs] dialog box, then click [Change/Remove].

For Windows 98/Me: Select [Canon CAPT Print Monitor] in the [Add/Remove 
Programs Properties] dialog box, then click [Add/Remove].
For Windows 2000: Select [Canon CAPT Print Monitor] in the [Add/Remove 
Programs] dialog box, then click [Change/Remove].

4 The dialog box that asks you whether the uninstallation can 
be started is displayed. Click [Yes].

Uninstallation starts. Please wait a moment.

5 If the uninstallation is completed successfully, the dialog box 
that informs you of the completion of the uninstallation is 
displayed. Click [OK].
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Uninstalling NetSpot Device Installer

1 From the [Start] menu, select [All Programs] ➞ [NetSpot 
Device Installer] ➞ [Uninstall NetSpot Device Installer].

For Windows 98/Me/2000: From the [Start] menu, select [Programs] ➞ [NetSpot 
Device Installer] ➞ [Uninstall NetSpot Device Installer].

Command Prompt (MS-DOS Prompt for Windows 98/Me) is displayed, and the 
uninstallation starts. Please wait a moment.
For Windows 2000/XP/Server 2003, the uninstallation is completed when 
Command Prompt exits.
For Windows 98/Me, the uninstallation is completed when the message <NetSpot 
Device Installer has been uninstalled successfully.> is displayed.

NOTE
If you did not add NetSpot Device Installer to the [Start] menu when you installed it, 
double-click [rmnsdi.bat] in the folder in which NetSpot Device Installer is installed.
Uninstalling the CAPT Software2-104
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Managing the Printer
You can perform the printer management, such as checking the printer status and 
specifying various settings, in a network environment using the following software. 
The specifiable options vary depending on the software. See "Network Setting 
Items" (p. 5-2) and use software appropriate to the network environment you are 
using or options that you want to specify.

■ Remote UI (See p. 3-3)
The Remote UI is software that allows you to manage the printer using a web browser. By 
accessing the printer from the web browser via a network, you can check the printer 
status or job history, and configure the network or security settings.

■ NetSpot Device Installer (See p. 3-34)
NetSpot Device Installer is software included in the CD-ROM supplied with the network 
board. Without installing it, you can run NetSpot Device Installer from the CD-ROM and 
specify the settings for the protocols or device information.

■ FTP Client (See p. 3-31)
FTP Client allows you to specify the settings for various information about the device and 
configure the network and security by accessing the FTP server on the network board 
using Command Prompt (MS-DOS Prompt for Windows 98/Me).
3-2 Managing the Printer
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This section describes the procedures for performing the following management 
options using the Remote UI.

• Restricting the Users Who Can Print (See p. 3-4)

• Restricting the Users Who Can Monitor/Change the Settings Using the SNMP 
Protocol (See p. 3-8)

• Restricting the Users Who Can Perform the Multicast Discovery (See p. 3-13)

• Restricting the Devices That Can Access with MAC Addresses (See p. 3-17)

• Obtaining/Checking the Security Access Logs (See p. 3-21)

• Initializing the Network Settings (See p. 3-28)

You can also perform these management options using FTP Client.

IMPORTANT
• If you are not sure about the IP address of the printer, refer to the Network Status Print 

printed in "Checking the Operations with Network Status Print" (p. 2-81) or ask your 
network administrator.

• Use Netscape Navigator/Communicator 4.7 or later or Internet Explorer 4.01SP1 or later 
as the web browser.

• You cannot connect the computer to the printer via a proxy server. If you are using a 
proxy server, perform the following settings. (The setting varies depending on the 
network environment.)
- On the settings for the proxy server of the web browser, add the IP address of the 

printer to [Exceptions] (The addresses that do not use the proxy server).
• Configure the web browser so that you can use Cookie.
• If multiple Remote UIs are running simultaneously, the latest setting is effective. It is 

recommended that only one Remote UI should be running at a time.

NOTE
Depending on the system environment, the screen for the Remote UI is not displayed. In 
this case, enter "http://<the IP address of the printer>/cab/top.shtml" in [Address] or 
[Location] to redisplay the screen.
3-3Managing the Printer Using the Remote UI
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Restricting the Users Who Can Print

IMPORTANT
This function restricts print commands only, not access from the Remote UI.

NOTE
• When you try to print from a computer whose IP address is rejected from being used for 

printing, the message <Cannot Print> is displayed.
• When you are using a computer whose IP address is rejected from being used for 

printing, some options cannot be set from the [Options] menu in the Printer Status 
Window.

• The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
3-4 Managing the Printer Using the Remote UI
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].

5 Select the [Restrict TCP/IP Printing] check box.
3-5Managing the Printer Using the Remote UI
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6 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].

NOTE
When [Permit Specified Addresses] is selected, only users specified in [IP 
Addresses] are permitted to perform printing. When [Reject Specified Addresses] 
is selected, only users specified in [IP Addresses] are rejected from performing 
printing.

7 Enter the IP address of a computer of which you want to 
permit or reject printing, and then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.
3-6 Managing the Printer Using the Remote UI
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To delete an IP address, select the IP address and click [Delete].

8 Click [OK].

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.
3-7Managing the Printer Using the Remote UI
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Restricting the Users Who Can Monitor/Change the 
Settings Using the SNMP Protocol

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].

5 Specify the SNMPv1 protocol.
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● When using the SNMPv1 protocol

❑ Set [SNMPv1] to [On].

❑ For [Access Rights], select in which mode the SNMPv1 agent can operate, 
[Read-only] or [Read and Write].

❑ Specify the community name of SNMP in [Community Name].

IMPORTANT
Selecting [Read-only] disables overwriting, and you cannot use some functions of 
Canon utility software or cannot use the software properly due to an error 
occurring.

● When not using the SNMPv1 protocol

❑ Set [SNMPv1] to [Off].

IMPORTANT
If [SNMPv1] is set to [Off], you may not be able to use Canon utility software. 
Consult the administrator of the printer before selecting [Off].

6 Specify the SNMPv3 protocol.

● When using the SNMPv3 protocol

❑ Set [SNMPv3] to [On].

❑ Specify the authentication key or privacy key to be used in SNMPv3 in 
[Authentication Key/Privacy Key].

❑ Enter the administrator password for the Remote UI in [Administrator 
Password].

IMPORTANT
If the settings for the SNMPv3 protocol is specified using application other than the 
Remote UI, the settings are not displayed in the Remote UI. To display the settings 
again, reset the network settings to the default values. For details on the procedure 
for resetting the network settings to the default values, see "Initializing the Network 
Settings," on p. 5-12.
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NOTE
• The user name to be used for the SNMPv3 protocol is set to "initial".
• If the password for the Remote UI is not specified, it is not required to enter a 

password in [Administrator Password].

● When not using the SNMPv3 protocol

❑ Set [SNMPv3] to [Off].

7 Select the [Restrict SNMP Monitoring/Setting Changes] check 
box.

8 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].

NOTE
When [Permit Specified Addresses] is selected, only users specified in [IP 
Addresses] are permitted to monitor/change the settings. When [Reject Specified 
Addresses] is selected, only users specified in [IP Addresses] are rejected from 
monitoring/changing the settings.
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9 Enter the IP address of a computer of which you want to 
permit or reject monitoring/changing the settings for the 
device, and then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.
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To delete an IP address, select the IP address and click [Delete].

10 Click [OK].

Restricting the Users Who Can Perform the Multicast 
Discovery

NOTE
• Multicast discovery is a function that searches for certain devices using the service 

location protocol (SLP). By using the multicast discovery function, you can search for 
only the devices whose values in [Scope Name] are verified, using the service location 
protocol (SLP) from utility software, such as NetSpot Device Installer.

• The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
3-13Managing the Printer Using the Remote UI



M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

3

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Information] from the [Device Manager] menu.
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4 Click [Change] on the right of [Security].

5 Select the [Restrict Multicast Discovery] check box.

6 Select [Respond to Specified IP Addresses] or [Do Not 
Respond to Specified Addresses].
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NOTE
When [Respond to Specified IP Addresses] is selected, only users specified in [IP 
Addresses] can receive responses to searches that used the multicast discovery 
function. When [Do Not Respond to Specified Addresses] is selected, only users 
specified in [IP Addresses] cannot receive responses to searches that used the 
multicast discovery function.

7 Enter an IP address that can receive or cannot receive 
responses to searches that used the multicast discovery, and 
then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.
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To delete an IP address, select the IP address and click [Delete].

8 Click [OK].

Restricting the Devices That Can Access with MAC 
Addresses

NOTE
• When you try to access to print etc. from a computer whose MAC address is rejected 

from accessing the printer, the message <Network Board Error> appears in the Printer 
Status Window.

• The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
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2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].
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5 Select the [Restrict MAC Address Access] check box.

6 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].

IMPORTANT
When [Permit Specified Addresses] is selected, you cannot access from an 
unauthorized MAC address. Therefore, confirm the MAC address when entering it. 
If there is no corresponding MAC address, you cannot access the network. In this 
case, you need to initialise the network settings. (See "Initializing the Network 
Settings," on p. 5-12)
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7 Enter the MAC address of a device of which you want to 
permit or reject accessing, and then click [Add].

Enter twelve-digit alphanumeric characters as 0123456789ab without separating 
them with a hyphen (-) or colon (:).

NOTE
Up to 20 MAC addresses can be entered.

To delete a MAC address, select the MAC address and click [Delete].
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8 Click [OK].

Obtaining/Checking the Security Access Logs

Obtaining a Security Access Log
If you have restricted the users who can print, who can monitor/change the settings 
using the SNMP protocol, or who can perform the multicast discovery in [IP 
Address Range Settings], you can obtain a security access log (The date and time 
when the access was locked, IP address, port number, and restriction type) when 
access from a restricted user is blocked. You can select whether to obtain a security 
access log by restriction type.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
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2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Information] from the [Device Manager] menu.
3-22 Managing the Printer Using the Remote UI



M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

3

4 Click [Change] on the right of [Security].

5 Select [On] or [Off] for [Access Logs].

If [On] is selected, the security access log is obtained when access from a user 
who is restricted in [IP Address Range Settings] is blocked.
If [Off] is selected, the security access log is not obtained when access from a 
user who is restricted in [IP Address Range Settings] is blocked.
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6 When [Access Logs] is set to [On], select any security access 
log that you want to obtain from [Log Types].

Options to be specified

NOTE
You can display, [Save], or [Clear] the obtained security access logs in [Security 
Access Log] page. To display the [Security Access Log] page, click [Display Log] in 
the [Information] page in the [Device Manager] menu in the Remote UI. For more 
details, see "Checking the Security Access Logs," on p. 3-25.

7 Click [OK].

[Rejected TCP/IP Print Jobs]: The security access log is recorded when access from a user 
who is rejected to perform the TCP/IP printing is blocked.

[Rejected SNMP Monitoring/
Setting Changes]:

The security access log is recorded when access from a user 
who is rejected to monitor/change the SNMP setting is 
blocked.

[Rejected Multicast 
Discoveries]:

The security access log is recorded when access from a user 
who is rejected to perform the multicast discovery is blocked.
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Checking the Security Access Logs
If you have restricted the users who can print, who can monitor/change the settings 
using the SNMP protocol, or who can perform the multicast discovery in [IP 
Address Range Settings], you can check the security access logs (The date and 
time when the access was locked, IP address, port number, and restriction type) 
that are obtained when access from a restricted user is blocked. It also allows you 
to [Save] or [Clear] the security access logs.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Display Log] under [Security].
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5 Check the security access logs in the [Security Access Log] 
page.

aaaa [Update Now]
Clicking this button obtains information about the date and time from the SNTP 
server. Reflects the obtained status to [Date and Time] and the SNTP server 
log according to success or failure of obtaining information.

bbbb [Date and Time]
Displays the date and time obtained from the SNTP server. The local time of 
the network board is displayed when the time and date could not be obtained 
for any reason, such as that the SNTP server address is not specified or there 
is no response from the SNTP server.

cccc [SNTP Server Log]
Displays the obtained status from the SNTP server.
When succeeded in obtaining the time and date from SNTP:

<Synchronized with the SNTP server at "The date and time when they 
were obtained".>
<Next synchronization in "The date and time when they are to be 
obtained next".>

While in the process of obtaining the date and time from SNTP:
<Getting time from SNTP Server.>

When failed to obtain the time and date from SNTP:
<Failed to get time from SNTP Server.>

dddd [Save]
Saves the obtained security access log in text format.

eeee [Clear]
Clears the obtained security access logs.

ffff [Security Access Log]
Displays the obtained security access logs. The date and time when the 
access was locked, IP address, port number, restriction type (any one of 
[PRINT] (Rejected TCP/IP Print Jobs), [SNMP] (Rejected SNMP Monitoring/
Setting Changes), or [SLP] (Rejected Multicast Discoveries)) are displayed.

a

b
c
d

e

f
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IMPORTANT
Up to 100 logs can be obtained. When the number of the logs exceeds 100, the 
logs are deleted starting from the oldest one.

Initializing the Network Settings
If you want to reset the network board to the default values, use any method from 
among Remote UI, FTP Client, and NetSpot Device Installer.

This section describes the procedure for initializing the network settings using the 
Remote UI. For details on initializing the network settings using FTP Client or  
NetSpot Device Installer, see "Initializing the Network Settings," on p. 5-12.

IMPORTANT
Make sure that the printer is not operating before initializing the network settings. If you 
initialize the print server while the printer is printing or receiving data, the received data 
may not be printed properly, or may result in paper jams or damage to the printer.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].
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NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Network] from the [Device Manager] menu.

4 Click [Show Parameter List] in [Network Interface].
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5 Click [Reset to Default Settings]

6 Clicking [Yes] initializes the network settings.

Clicking [No] does not initialize the network settings but displays the original 
page.
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You can manage the printer with FTP Client using the following procedure. Also, 
you can upgrade the firmware.

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs]  ➞ 
[Accessories] ➞ [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs]  ➞ [Accessories]  
➞ [Command Prompt].
For Windows Me: From the [Start] menu, select [Programs]  ➞ [Accessories]  ➞ 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs]  ➞ [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

Input Example : ftp 192.168.0.215

NOTE
If you are not sure about the IP address of the printer, refer to the Network Status 
Print printed in "Checking the Operations with Network Status Print" (p. 2-81) or 
ask your network administrator.

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

● If the password is specified for the printer

❑ Enter the password.

● If the password is not specified for the printer

❑ Do not enter the password, but press the [ENTER] key on your keyboard.

NOTE
You can log in by entering a name other than "root" (or leaving the field blank). In 
this case, you can perform operations other than settings.
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4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.

IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
• When upgrading the firmware, enter "put <the update file of the firmware> FLASH", 

then press the [ENTER] key on your keyboard. For details on the update file of the 
firmware, see "Updating the Firmware," on p. 5-29.

• You can obtain the default values of the network settings by entering "get defaults" 
and pressing the [ENTER] key on your keyboard to download the list of the default 
values of the network settings.

• The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.

5 Using Notepad, etc., edit downloaded the config file.

For details on descriptions of each option, see "Network Setting Items," on p. 5-2.

6 Enter the following command, then press the [ENTER] key on 
your keyboard.

put <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

7 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).
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8 Enter "quit", then press the [ENTER] key on your keyboard.

9 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.
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Managing the Printer Using NetSpot Device Installer
You can perform the basic protocol settings and display the status of the printers on 
a network using NetSpot Device Installer. This section describes the procedure for 
running or installing NetSpot Device Installer. For details on the procedures for 
using NetSpot Device Installer, see Online Help of NetSpot Device Installer.

Configurable Devices
NetSpot Device Installer allows you to initialize the network protocols of the devices 
connected to a TCP/IP network. You cannot configure the devices connected to a 
network other than the TCP/IP network using NetSpot Device Installer.

Printer

Printer
Protocol : TCP/IP

Printer

USB

USB
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Installing NetSpot Device Installer
Install NetSpot Device Installer using the following procedure.

IMPORTANT
• Close all the other applications before the installation.
• If you are using Windows 2000/XP/Server 2003, be sure to log on as a member of 

Administrators when starting up.
• If you are using Windows XP Service Pack 2 or another operating system equipped with 

Windows Firewall, and the Windows Firewall is enabled, you cannot search for the 
printers on a subnet that is different from the one that the computers using NetSpot 
Device Installer are on. To search for such a printer, add NetSpot Device Installer to 
Windows Firewall during the installation.

NOTE
• NetSpot Device Installer is utility software that you can use without installing it. When 

using NetSpot Device Installer without installing it, read "Running NetSpot Device 
Installer," on p. 3-40.

• You can expand the functions of NetSpot Device Installer by adding Plug-Ins. When using 
the functions of Plug-Ins, install both NetSpot Device Installer and Plug-Ins on the 
computer. For more details on Plug-Ins, see Readme of NetSpot Device Installer.

• Readme of NetSpot Device Installer is in [Readme_English.html] in the following folder in 
the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows

• The screen shots used in this section are from Windows XP Professional.
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1 Insert the CD-ROM supplied with the network board into the 
CD-ROM drive.

2 Open [My Computer], then select the CD-ROM drive.

3 Select [Open] from the [File] menu.
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4 Double-click the [NetSpot_Device_Installer] folder.

5 Double-click the [Windows] folder.
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6 Double-click [nsdisetup.exe].

7 Click [Yes].
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8 Click [Browse], then select the installation directory.

If you want to add NetSpot Device Installer to the [Start] menu, select the [Add to 
Start Menu] check box.

9 Click [OK].

Installation of NetSpot Device Installer is started.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, the 
following screen is displayed.

If you want to register the application, click [Yes]. If you click [No], you cannot 
search for the printers in which the IP address has not been set yet or the printers 
on a subnet that is different from the one that the computer using NetSpot Device 
Installer is on.
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10 The screen that informs you of the completion of the printer 
driver installation is displayed. Click [OK].

11 Next, select the Plug-Ins that you want to install, then click 
[Start Installation].

If you do not want to install any Plug-Ins, click [Cancel] to exit. 
For more details on Plug-Ins, see the Readme file of NetSpot Device Installer.

NOTE
You can install Plug-Ins later. For details on installing Plug-Ins later, see the 
Readme file. 
Readme of NetSpot Device Installer is in [Readme_English.html] in the following 
folder in the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows

The installation of NetSpot Device Installer is completed.

Running NetSpot Device Installer
This section describes the procedure for running NetSpot Device Installer.

When Running NetSpot Device Installer Installed on a Computer

NOTE
The screen shots used in this section are from Windows XP Professional.
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1 From the [Start] menu, select [All Programs] ➞ [NetSpot 
Device Installer] ➞ [NetSpot Device Installer].

For Windows 98/Me/2000: From the [Start] menu, select [Programs] ➞ [NetSpot 
Device Installer] ➞ [NetSpot Device Installer].

NetSpot Device Installer runs.

NOTE
If you did not add NetSpot Device Installer to the [Start] menu when you installed it, 
double-click [nsdi.exe] in the folder in which NetSpot Device Installer is installed.

When Running NetSpot Device Installer from the CD-ROM Supplied 
with the Network Board

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Insert the CD-ROM supplied with the network board into the 
CD-ROM drive.

2 Open [My Computer], then select the CD-ROM drive.
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3 Select [Open] from the [File] menu.

4 Double-click the [NetSpot_Device_Installer] folder.
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5 Double-click the [Windows] folder.

6 Double-click [nsdi.exe].

NetSpot Device Installer runs.

How to Use NetSpot Device Installer
For details on the procedure for setting the IP address using NetSpot Device 
Installer, see "IP Address Setting Using NetSpot Device Installer," on p. 2-30. For 
more details on other procedures for using NetSpot Device Installer, see Online 
Help.

Online Help is displayed by clicking [Help] in the [Help] menu.
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Troubleshooting
This chapter describes the troubleshooting procedures for problems occurred in the network 
environment.
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Installation Problems
If the printer driver cannot be installed properly, perform the following procedure to 
check problems.

NOTE
For installation problems when the printer and computer are connected by a USB cable, 
see "User's Guide".

Uninstall the CAPT software 
with Uninstaller.
See "Uninstalling the CAPT 
Software," on p. 2-100.

Uninstall the CAPT software 
with Uninstaller.
See "Uninstalling the CAPT 
Software," on p. 2-100.

Delete your printer from [Add or 
Remove Programs] ([Add/Remove 
Programs] on Windows 2000; 
[Add/Remove Programs 
Properties] on Windows 98/Me).
See "When Uninstallation Fails," 
on p. 4-5.

Install the CAPT software 
again.
See "Installing the CAPT Software 
from CD-ROM Setup," on p. 2-2. Install the CAPT software 

again.
See "Installing the Printer Driver 
Manually Using Various Utility 
Software," on p. 2-29.

Install the CAPT software 
again.
See "Installing the Printer 
Driver Manually Using 
Various Utility Software," on 
p. 2-29.

[Canon Printer 
Uninstaller] is displayed in 

[All Programs] ([Programs] for 
Windows 98/Me/2000) from 

the [Start] menu.

Your printer is displayed 
in [Add or Remove Programs] 
([Add/Remove Programs] on 
Windows 2000; [Add/Remove 

Programs Properties] on 
Windows 98/Me).

Print a test page.
See "Printing a Test Page," on p. 4-4.

Cannot 
print

The icon for 
your printer is displayed 

in the [Printers and Faxes] 
or [Printers] folder.

No

Yes

Yes

NoNo

Cannot 
uninstall

Cannot 
install

Yes

A problem has occurred 
during the installation.

No

Yes

Check the power supply, cables, 
etc. See "Problems on Local 
Installation" on p. 4-3.
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Problems on Local Installation

NOTE
For installation problems when the printer is shared on a network, see "User's Guide".

When the printer driver is installed from the CD-ROM Setup, the printer cannot be searched 
for.

 

Cause 1 The printer is OFF.
 

Remedy Turn the printer ON.
 

Cause 2 The printer and cable are not connected properly.
 

Remedy Make sure that the printer is connected to the network by an appropriate cable, 
and then cycle the power of the printer.

 

Cause 3 You are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall.

 

Remedy Click [Yes] in the following screen displayed during the installation to unblock 
Windows Firewall temporarily. The block is enabled again after the installation is 
completed.

The printer to be used cannot be searched for in NetSpot Device Installer.
 

Cause 1 The printer is OFF.
 

Remedy Turn the printer ON.
 

Cause 2 The printer and cable are not connected properly.
 

Remedy Make sure that the printer is connected to the network by an appropriate cable, 
and then cycle the power of the printer.

 

Cause 3 You are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall.

 

Remedy If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, you 
need to add "NetSpot Device Installer" to Windows Firewall. Perform either of 
the following procedures.
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• Adding "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows 
Firewall] dialog box (See Readme of NetSpot Device Installer)

• Installing NetSpot Device Installer (You can add it to Windows Firewall during 
the installation) (See p. 3-35) 

Readme of NetSpot Device Installer is in [Readme_English.html] in the 
following folder in the CD-ROM supplied with the network board. 
\NetSpot_Device_Installer\Windows

Printing a Test Page
Check the following items if nothing is printed when printing from an application:

1 Check if any error message is displayed in the Printer Status 
Window.

IMPORTANT
If any error message appears, follow the directions in the message displayed in the 
Printer Status Window. For details on the Printer Status Window, see "User's 
Guide".

2 Print a test page.

● For Windows 98/Me

❑ Select the icon for the printer in the [Printers] folder, then select [Properties] 
from the [File] menu.

❑ Click [Print Test Page] in the [General] sheet in the [Printer Properties] dialog 
box.

● For Windows 2000/XP/Server 2003

❑ Select the icon for the printer in the [Printers and Faxes] or [Printers] folder, 
then select [Properties] from the [File] menu.

❑ Click [Print Test Page] in the [General] sheet in the [Printer Properties] dialog 
box.

■ When the test page is printed correctly
Printing can be performed from the CAPT software. Check the application to make sure 
that all the settings are specified properly.

■ When the test page cannot be printed
See "Installation Problems," on p. 4-2.
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When Uninstallation Fails
If you cannot uninstall the CAPT software using the Uninstaller that was created 
during installation, use the following procedure to uninstall the CAPT software from 
[Add or Remove Programs] ([Add/Remove Programs Properties] for Windows 98/
Me; [Add/Remove Programs] for Windows 2000).

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 From the [Start] menu, select [Control Panel], and then click 
[Add or Remove Programs].

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Control 
Panel], and then double-click [Add/Remove Programs].
For Windows Server 2003: From the [Start] menu, select [Control Panel] ➞ [Add 
or Remove Programs].

2 Select the name of your printer in the [Add or Remove 
Programs] dialog box, then click [Change/Remove].

For Windows 2000: Select the name of your printer in the [Add/Remove 
Programs] dialog box, then click [Change/Remove].
For Windows 98/Me: Select the name of your printer in the [Add/Remove 
Programs Properties] dialog box, then click [Add/Remove].
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NOTE
If the name of the printer is not displayed in the dialog box, perform "Installing the 
Printer Driver Manually Using Various Utility Software" (p. 2-29) to install the CAPT 
software again.

3 Select the name of the printer, then click [Delete].

A confirmation message is displayed.

4 Click [Yes].

If the printer is being used as a shared printer, the following screen appears. 
Confirm the contents of the message, and then click [Yes] if you want to uninstall 
the printer driver.

Uninstallation starts. Please wait a moment.
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5 Click [Exit].

The [Delete Printer] dialog box closes.

6 Restart Windows.
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When Data is Not Sent to the Printer
The following are probable causes when the printer and computer are connected 
by a LAN cable, and the data cannot be printed because it is not sent to the printer. 
Take the appropriate measures.

NOTE
• Because there may be other causes of the symptom, also see "Miscellaneous 

Problems," on p. 4-11.
• If the printer is connected to the computer by a USB cable or is being shared on a 

network, see "User's Guide".

The printer is not turned ON.
 

Cause 1 The power plug is unplugged from the AC power outlet.
 

Remedy Plug the power plug into the AC power outlet.
 

Cause 2 The printer is plugged to an extension cord or multiple power strip.
 

Remedy Plug the power plug of the printer directly into an AC power outlet on the wall.
 

Cause 3 The breakers have tripped.
 

Remedy Reset the breakers on the switch board.
 

Cause 4 There is a break in the power cord.
 

Remedy If the printer is turned ON after replacing the power cord with the one that is of 
the same type and is used for other device, there is a break in the power cord. 
In this case, purchase a new power cord and replace it with the broken one.

The LAN cable is not connected properly.

Cause The LAN cable is disconnected.

Remedy Make sure that the printer and computer are connected with the LAN cable 
properly.
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An inappropriate port is being used.
 

Cause 1 The port to be used is not selected properly.
 

Remedy Perform the following procedure.

1. Display the [Printers and Faxes] folder or the [Printers] folder.
- For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ 

[Printers].
- For Windows XP Professional/Server 2003: From the [Start] menu, select 

[Printers and Faxes].
- For Windows XP Home Edition: From the [Start] menu, select [Control 

Panel], and then click [Printers and Other Hardware] ➞ [Printers and 
Faxes].

2. Select the icon for the printer, then select [Properties] from the [File] menu.
3. Display the [Ports] sheet ([Details] sheet for Windows 98/Me), then make 

sure that the port to be used is selected properly.

If the appropriate port is not selected, select the appropriate one, and then 
click [OK]. 
If you cannot find the port to be used, uninstall the printer driver and install it 
again. (See "Uninstalling the CAPT Software," on p. 2-100, "Installing the 
CAPT Software," on p. 2-2)

 

Cause 2 You changed the IP address.
 

Remedy If you changed the IP address, see "Changing the Port" (p. 5-18) and set the 
port anew.
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The IP address is incorrect.
 

Cause The IP address is not set properly.
 

Remedy 1 Make sure that the IP address is set properly.

NOTE
Use the following checking procedures.

1. Run Command Prompt or MS-DOS Prompt.

- For Windows XP/Server 2003: From the [Start] menu, select [All Programs] ➞ 
[Accessories] ➞ [Command Prompt].

- For Windows 2000: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[Command Prompt].

- For Windows Me: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[MS-DOS Prompt].

- For Windows 98: From the [Start] menu, select [Programs] ➞ [MS-DOS Prompt].
2. Enter "ping <the IP address of the printer>", then press the [ENTER] key on your 

keyboard.

- Input Example: ping 192.168.0.215

3. If the IP address is set properly, the following command (indicating that the signals 
are sent four times and are received four times successfully) is displayed.
- Packets: Sent = 4, Received = 4, Lost = 0 (0% loss), 
If any command like the following command is displayed, consult your network 
administrator.
- Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),

4. Enter "exit", then press the [ENTER] key on your keyboard.
 

Remedy 2 Before setting the IP address using any one of DHCP, BOOTP, or RARP, make 
sure that the protocol is running. (See "Protocol Settings for the Printer," on p. 
2-84)
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NOTE
For details on problems on the printer such as a paper jam and poor printing quality, see 
"User's Guide".

Cannot Print from the Network
 

Cause 1 The network board and cable are not connected properly.
 

Remedy Check the following points, and then cycle the power of the printer.

• Make sure that the network board is installed properly. (See the instruction 
manuals supplied with the printer)

• Make sure that the printer is connected to the network by an appropriate 
cable. (See the instruction manuals supplied with the printer)

 

Cause 2 The network is not configured properly.
 

Remedy 1 Make sure that the IP address is set properly.

NOTE
Use the following checking procedures.

1. Run Command Prompt or MS-DOS Prompt.

- For Windows XP/Server 2003: From the [Start] menu, select [All Programs] ➞ 
[Accessories] ➞ [Command Prompt].

- For Windows 2000: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[Command Prompt].

- For Windows Me: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[MS-DOS Prompt].

- For Windows 98: From the [Start] menu, select [Programs] ➞ [MS-DOS Prompt].
2. Enter "ping <the IP address of the printer>", then press the [ENTER] key on your 

keyboard.

- Input Example :ping 192.168.0.215

3. If the IP address is set properly, the following command (indicating that the signals 
are sent four times and are received four times successfully) is displayed.
- Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
If any command like the following command is displayed, consult your network 
administrator.
- Packets: Sent = 4, Received = 0, Lost = 4 (100% loss),

4. Enter "exit", then press the [ENTER] key on your keyboard.
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Remedy 2 Before setting the IP address using any one of DHCP, BOOTP, or RARP, make 
sure that the protocol is running. (See "Protocol Settings for the Printer," on p. 
2-84)

 

Cause 3 The port is not set properly.
 

Remedy 1 If you changed the IP address after installing the printer driver, set the port 
anew. (See "Changing the Port," on p. 5-18) 
If you want to specify Canon CAPT Port when you install the printer driver from 
the [Printers and Faxes] folder or the [Printers] folder or by setting the port 
manually using the CD-ROM (CD-ROM Setup) supplied with the printer, be sure 
to install Canon CAPT Print Monitor before installing the printer driver. (See 
"Installing the Printer Driver Manually Using Various Utility Software," on p. 
2-29)

 

Remedy 2 If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the port is set to Canon CAPT Port, make 
sure that Windows Firewall is configured to unblock communication with Canon 
CAPT Print Monitor.

NOTE
Use the following checking procedures.

1. From the [Start] menu, select [Control Panel], and then click [Network and Internet 
Connections] ➞ [Windows Firewall].

2. Make sure that the [Canon CAPT Port] check box is selected in the [Exceptions] 
sheet in the [Windows Firewall] dialog box. If the check box is not selected, select 
it.

 

Cause 4 The computer that performs printing is not configured properly.
 

Remedy Check the following points.

• Make sure that the printer is specified as the default printer.

• Make sure that the printer driver is installed properly. In order to check if the 
printer driver is installed properly, perform Network Status Print (See 
"Checking the Operations with Network Status Print," on p. 2-81). If you 
cannot print properly, uninstall the printer driver and install it again. (See 
"Uninstalling the CAPT Software," on p. 2-100, "Installing the CAPT 
Software," on p. 2-2)

• Make sure that the TCP/IP protocol is running.
 

Cause 5 The IP address of the computer that sends the print data is restricted in 
[Restrict TCP/IP Printing] in [IP Address Range Settings].

 

Remedy Confirm the setting of [Restrict TCP/IP Printing] in [IP Address Range Settings]. 
See "Restricting the Users Who Can Print," on p. 3-4
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Cause 6 The network board is set to the unicast communication mode.
 

Remedy Specify the normal mode (the broadcast communication mode). For more 
details, see "Using the Unicast Communication Mode" (p. 5-26) or ask your 
network administrator.

All the indicators on the network board are off.

Cause 1 The LAN cable is not connected properly or broken.

Remedy 1 Remove the LAN cable once, then connect it again.

Remedy 2 Replace the LAN cable with another one, then connect it.

Cause 2 The cable is connected to the UP-LINK (cascade) port on the hub.

Remedy 1 Connect the LAN cable to a port with a "X" mark.

Remedy 2 If the hub has a UP-LINK (cascade) switch, switch to "X".

Cause 3 A cross LAN cable is being used.

Remedy 1 Replace the cable with a straight LAN cable.

Remedy 2 Connect the cross LAN cable to the UP-LINK (cascade) port on the hub. If the 
hub has a UP-LINK (cascade) switch, switch to "=".

NOTE
A cross LAN cable is a cable used to connect to a printer and computer directly.

Cause 4 Cannot communicate with the hub.

Remedy 1 Make sure that the power of the hub is on.

Remedy 2 Set the DIP switches on the netowork board according to the transmission 
speed of the connected hub. (See User's Guide)

Remedy 3 Replace the hub.

Cause 5 The network board is not installed properly.

Remedy Remove the network board once, then install it again.

Cause 6 The hardware of the network board is in an abnormal condition.

Remedy Report the problems to your local authorized Canon dealer.
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The ERR indicator on the network board is on.

Cause The LAN cable is disconnected or broken, or the network board is not installed 
properly.

Remedy 1 Make sure the LAN cable is connected properly.

Remedy 2 Replace the LAN cable with a proper one and check if there is no disconnection 
or damage.

Remedy 3 If the ERR indicator still comes on even after applying the Remedy 1 and 2, 
contact your local Canon dealer for servicing.

The ERR indicator on the network board blinks at an interval of four times.

Cause The DIP switch 1 on the network board is on.

Remedy Set the DIP switch 1 to OFF once. (See "Initializing the Network Settings," on p. 
5-12)

The ERR indicator on the network board keeps blinking.

Cause The hardware of the network board is in an abnormal condition.

Remedy Contact your local authorized Canon dealer for servicing.

Canon CAPT Print Monitor cannot be uninstalled.
 

Cause 1 The printer driver has not been uninstalled.
 

Remedy If the printer driver is installed, Canon CAPT Print Monitor cannot be 
uninstalled. Uninstall the printer driver before uninstalling Canon CAPT Print 
Monitor. (See "Uninstalling the Printer Driver," on p. 2-100)

 

Cause 2 The printer is assigned to Canon CAPT Port.
 

Remedy Display the [Printer Properties] dialog box from the [Printers and Faxes] folder 
or the [Printers] folder, and then specify a port other than Canon CAPT Port in 
the [Ports] sheet (the [Details] sheet for Windows 98/Me).

The printer became unable to print from the network suddenly.

Cause When using the printer in a DHCP environment etc, you turned OFF or ON the 
printer.

Remedy If you want to use the printer in a DHCP environment etc., set DHCP etc. so that 
the same IP address is always assigned to the printer when starting up the 
printer.
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NOTE
Because there may be other causes of the symptom, also see the Cause 1 and 2 of 
"Cannot print from the network.", "All the indicators on the network board are off.", "The 
ERR indicator on the network board is on.", "The ERR indicator on the network board 
blinks at an interval of four times.", and "The ERR indicator on the network board keeps 
blinking.".

It takes a long time to obtain the status in the Printer Status Window.

Cause You are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall and Standard TCP/IP Port.

Remedy See the procedure from Step 18 of "Installing the CAPT Software from 
CD-ROM Setup" (See p. 2-14) and specify the settings so that the port is 
opened through Windows Firewall.
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Checking the Network Board Functions
The printer driver is provided with a function of Network Status Print that allows you 
to check the version of the network board or the TCP/IP settings. Use these 
functions when required after setting the network environment, for example when 
you want to check the operation of the network board.

NOTE
• Network Status Print is designed to be printed on A4 size paper. Load A4 size paper.
• The screen shots used in this section are from Windows XP Professional with which 

LBP5100 is being used.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] ➞ [Printers and Faxes].

2 Select the icon for your printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for your printer, then select [Properties] from 
the [File] menu.
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3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".

4 From the [Options] menu, select [Utility] ➞ [Network Status 
Print].
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5 Click [OK].

Network Status Print is printed.

6 Confirm the contents of the Network Status Print.

Network Status Print prints information as shown in the following figure. You can 
check the version of the network board or the TCP/IP settings.

IMPORTANT
This is a sample of Network Status Print. The contents may differ from the Network 
Status Print printed by your printer.
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Network Setting Items
You can change the network settings by using the web browser (Remote UI), FTP 
Client, or NetSpot Device Installer. The following are the setting items that you can 
change.

NOTE
• The letters shown in parentheses are exclusively for FTP Client (Example: "Device Name 

(DEVICE_NAME)" is indicated as [Device Name] in the Remote UI and NetSpot Device 
Installer, and indicated as [DEVICE_NAME] in the config file in the FTP Client.).

• The asterisk marks attached to the end of some option names, such as "*1", indicate the 
following:
*1: Cannot be specified using NetSpot Device Installer. Specify these options using the Remote UI or FTP 

Client.

*2: Can be specified using FTP Client only.

■ General Settings

Option Contents Default

[Print Server Name]
(PS_NAME) *1

The name of the network board (print 
server) (0 to 15 characters)

CANONXX
XXXX

[Device Name]
(SYS_NAME)

The name of the device (0 to 32 
characters)

(Blank)

[Location]
(SYS_LOC)

The installation site of the device (0 to 
32 characters)

(Blank)

[Administrator]
(SYS_CONTACT)

The name of the administrator of the 
device (0 to 32 characters)

(Blank)

[Phone]
(SYS_CONTACT_TEL) *1

The telephone number of the 
administrator of the device (0 to 32 
characters)

(Blank)

[Comments]
(SYS_CONTACT_COMMENT) 
*1

Comments by the administrator of the 
device (0 to 32 characters)

(Blank)

(SERVICE_MAN_NAME) *2 The name of the service person (0 to 32 
characters)

(Blank)

(SERVICE_TEL) *2 The telephone number of the service 
person (0 to 32 characters)

(Blank)
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(SERVICE_COMMENT) *2 Comments by the service person (0 to 
32 characters)

(Blank)

[Administrator Password]
(ROOT_PWD)

The password of the device (0 to 15 
characters)

(Blank)

[Display Language] 
(DISP_LANG) *1

The languages displayed in the Remote 
UI (English, French, German, Italian, 
Spanish, Japanese, Default)

Default

[Link]
(LINK_NAME1) *1

(LINK_NAME2) *1

The link displayed in the [Support Links] 
page in the Remote UI (0 to 32 
characters)

(Blank)

[URL]
(LINK_URL1) *1

(LINK_URL2) *1

The URL displayed in the [Support 
Links] page in the Remote UI (0 to 128 
characters)

(Blank)

[Comments]
(LINK_COMMENT1) *1

(LINK_COMMENT2) *1

The comments displayed in the [Support 
Links] page in the Remote UI (0 to 64 
characters)

(Blank)

[Link]
(DOWNLOAD_SITE_NAME) *1

The link displayed in the [Support Links] 
page in the Remote UI (0 to 32 
characters)

Download 
Service

[URL]
(DOWNLOAD_SITE_URL) *1

URL displayed in the [Support Links] 
page in the Remote UI/URL selected by 
clicking [Device Manager] in the Remote 
UI - the [Network] page - [Download 
Site] under [Firmware] (0 to 128 
characters)

http://
www.canon
.com/
download/

[Comment]
(DOWNLOAD_SITE_COMMEN
T) *1

The comments displayed in the [Support 
Links] page in the Remote UI (0 to 64 
characters)

Update 
network 
firmware

[SNMPv1]
(SNMP_V1_ACCESS_ENB)  *1 Access using the SNMPv1 protocol YES

[Access Rights]
(SNMP_V1_ACCESS_MODE) 
*1

SNMPv1 agent's operation mode
(Read-Only, Read-Write)

Read and 
Write

[Community Name]
(PUB_COMMUNITY) *1

The community name of SNMP (0 to 32 
characters)

public

[SNMPv3]
(SNMP_V3_ACCESS_ENB) *1 Access using the SNMPv3 protocol NO

Option Contents Default
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[Restrict TCP/IP Printing]
(TCP_CONT_ENB) *1

Whether to restrict the users who can 
print

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(TCP_CONT_MODE) *1

Accept or reject the jobs by a user 
whose name is entered in [IP 
Addresses] (TCP_CONT_LIST) 
(Accept, Reject)

Accept

[IP Addresses]
(TCP_CONT_LIST) *1

The IP addresses rejected to perform 
TCP/IP printing

(Blank)

[Restrict SNMP Monitoring/
Setting Changes]
(SNMP_CONT_ENB) *1

Whether to restrict users who can 
monitor/change the SNMP setting

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(SNMP_CONT_MODE) *1

Accept or reject monitoring/changing the 
settings for the device using the SNMP 
protocol by a user whose name is 
entered in [IP Addresses] 
(SNMP_CONT_LIST) (Accept, Reject)

Accept

[IP Addresses]
(SNMP_CONT_LIST) *1

The IP addresses rejected to monitor/
change the SNMP setting

(Blank)

[Restrict Multicast Discovery]
(SLP_CONT_ENB) *1

Whether to restrict the users who can 
perform the multicast discovery

NO

[Respond to Specified IP 
Addresses]/
[Do Not Respond to Specified 
Addresses]
(SLP_CONT_MODE) *1

Accept or reject the searches that used 
the multicast discovery by a user whose 
name is entered in [IP Addresses] 
(SLP_CONT_LIST) (Accept, Reject)

Accept

[IP Addresses]
(SLP_CONT_LIST) *1

The IP addresses rejected to perform 
the multicast discovery

(Blank)

[Restrict MAC Address Access]
(MAC_CONT_ENB)

Whether to restrict the devices that can 
access

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(MAC_CONT_MODE)

Accept or reject the access by a device 
whose name is entered in [MAC 
Addresses] (MAC_CONT_LIST) 
(Accept, Reject)

Accept

[MAC Addresses]
(MAC_CONT_LIST)

The MAC addresses permitted or 
rejected to access

(Blank)

[Access Logs]
(SEC_LOG_ENB) *1 Whether to obtain a security access log NO

Option Contents Default
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■ TCP/IP Settings

[Log Types]
(SEC_LOG_KIND) *1

Security access logs to obtain
0: No Access Log to Obtain
1: Rejected TCP/IP Print Jobs
2: Rejected SNMP Monitoring/Setting 
Changes
3: Rejected TCP/IP Print Jobs and 
Rejected SNMP Monitoring/Setting 
Changes
4: Rejected Multicast Discoveries
5: Rejected TCP/IP Print Jobs and 
Rejected Multicast Discoveries
6: Rejected SNMP Monitoring/Setting 
Changes and Rejected Multicast 
Discoveries
7: Access All the Logs

0

Option Contents Default

[Frame Type]
(TCP_FRAME_TYPE)

The frame type being used by TCP/IP
Ethernet 
II

(G_ARP_ENB) *2 Whether to use the Gratuitous ARP 
function

YES

[DHCP]
(DHCP_ENB)

Whether to use DHCP for the IP address 
setting

NO

[BOOTP]
(BOOTP_ENB)

Whether to use BOOTP for the IP address 
setting

NO

[RARP]
(RARP_ENB)

Whether to use RARP for the IP address 
setting

NO

[IP Address]
(INT_ADDR)

The IP address of the printer
192.168.
0.215

[Subnet Mask]
(NET_MASK)

Subnet Mask 0.0.0.0

[Gateway Address]
(DEF_ROUT)

Gateway Address 0.0.0.0

[DNS Server Address]
(DNS_ADDR) *1 The IP address of the DNS server 0.0.0.0

[DNS Dynamic Update]
(DDNS_ENB) *1

Whether to register this device in DNS 
dynamically

NO

Option Contents Default
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[DNS Host Name]
(HOST_NAME) *1

The host name of this device (0 to 63 
characters)

(Blank)

[DNS Domain Name]
(DOMAIN_NAME) *1

The name of the domain to which this 
device belong (0 to 64 characters)

(Blank)

[WINS Resolution]
(WINS_ENB) *1 Whether to use WINS Resolution YES

[WINS Server Address]
(WINS_ADDR1) *1 WINS Server Address 0.0.0.0

[WINS Host Name]
(WINS_HOSTNAME) *1

Registration of the host name of WINS (0 
to 15 characters)

(Blank)

[Scope ID]
(NBT_SCOPE_ID) *1

The identifier to specify the 
communication range of the printer and 
computer (0 to 220 characters)

(Blank)

[SNTP Server Name]
(SNTP_ADDR) *1

The IP address or name of the SNTP 
server (0 to 64 characters)

(Blank)

(SNTP_CHECK_
INTERVAL) *2

The time interval for updating SNTP
(10min, 30min, 1hours, 3hours, 6hours, 
12hours, 24hours)

1hours

[Multicast Discovery Settings]
(SLP_ENB) *1

Whether to receive responses to searches 
that used the multicast discovery

YES

[Scope Name]
(SLP_SCOPE) *1

The scope name to be used in the 
multicast discovery (0 to 32 characters)

default

(USE_IP_PORT_NAME)*2 Whether to use the unicast 
communication mode

NO

[Time Zone]
(TIME_ZONE)

Time Zone
GMT
+ 0: 00

[Daylight Saving Time]
(DAYLIGHT_SAVING)

Whether to set the daylight saving time YES

Option Contents Default
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You can perform the network settings using the following software

O: Specifiable 
-: Not specifiable

* Some settings are specifiable (See "Network Setting Items," on p. 5-2)

Setting
Web 

Browser 
(Remote UI)

FTP Client
NetSpot 
Device 

Installer

ARP/PING 
Command

Printer 
Status 

Window

Resetting the IP 
address (See p. 
2-30, p. 2-40, p. 
2-42)

- - O O O

Protocol settings
(See p. 2-84)

O O O* - -

Restricting the users 
who can print (See p. 
3-4, p. 3-31)

O O - - -

Restricting the users 
who can monitor/
change the settings 
using the SNMP 
protocol (See p. 3-8, 
p. 3-31)

O O - - -

Restricting the users 
who can use the 
multicast discovery
(See p. 3-13, p. 3-31)

O O - - -

Restricting MAC 
address access
(See p. 3-17, p. 3-31)

O O - - -

Obtaining a security 
access log
(See p. 3-21, p. 3-31)

O O - - -
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Setting the Network Board
The default value of the network board is set at "Auto detect". Usually, you do not 
need to change the setting, since the transmission speed and transfer mode of 
10BASE-T/100BASE-TX are detected automatically. If the printer cannot 
communicate with other devices on the network, set the DIP switches on the 
network board. Before setting the DIP switches, turn the printer OFF, then remove 
the network board. A Phillips screwdriver is required for removing the network 
board. Have a screwdriver ready in advance that matches the size of the screws. 
Set the DIP switches according to the transmission speed of the connected network 
as follows.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with the tip of a 
ball-point pen etc. Do not use a sharp object such as a mechanical pencil.

ERR LNK 100

ON

OFF OFF

1 2 3 4

DIP switches

* Shown above is the Auto 
  detect setting (default 
  setting)
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■ Setting the Network Transmission Speed/Transfer Mode and the DIP 
Switches

1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable.

3 Disconnect the power plug from the AC power outlet.

4 Remove all the interface cables and the power cord from the 
printer.

NOTE
If the optional duplex unit is installed, remove it from the printer. For details on the 
procedure for removing the duplex unit, see "User's Guide".

Communication speed and 
Transmission mode of LAN

10BASE-T/Half-duplex

ON

OFF

ON

OFF

ON

OFF

ON

OFF

ON

OFF

Auto detect (default setting)

10BASE-T/Full-duplex

100BASE-TX/Half-duplex

100BASE-TX/Full-duplex

DIP switch setting

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4

OFF

1 2 3 4
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5 Remove the two screws and remove the network board.

IMPORTANT
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

6 Set the DIP switches.

Set the DIP switches with the tip of a ball-point pen etc. For details on methods 
for setting the DIP switches, see the table of p. 5-9.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with the 
tip of a ball-point pen etc. Do not use a sharp object such as a mechanical pencil.

7 Insert the network board into the expansion slot.

Hold the metal panel portions of the network board and insert the board straight 
while aligning it with the guide rails inside the expansion slot.

IMPORTANT
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Insert the network board securely.

8 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

9 Connect the LAN cable.

10 Connect the power cord.

ERR LNK 100

ON

OFF OFF

1 2 3 4

DIP switches
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11 Plug the power plug into the AC power outlet.

 

12 If you are going to print via USB also, connect the USB cable.
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Initializing the Network Settings
If you want to reset the network settings to the default values, use any method from 
among Remote UI, FTP Client, and NetSpot Device Installer.

• Remote UI: See "Initializing the Network Settings," on p. 3-28.

• FTP Client: See "Managing the Printer Using FTP Client," on p. 
3-31.

• NetSpot Device Installer: 1. Select the name of the printer that you want to 
reset, and then select [Restore to Default Settings] 
from the [Device] menu.

2. If a message appears, click [Yes].

3. If the message <The Device has been reset.> is 
displayed, click [OK]. To perform a reset operation 
properly, wait for approximately 20 seconds or 
longer as is after clicking [OK]. The settings are 
effective after resetting of the network board is 
completed. If the message <Turn the device off 
and then on again.> is displayed, the settings are 
effective after clicking [OK] and cycling the power 
of the printer.

Even if none of the above procedures work, you can reset the network settings by 
manipulating the DIP switches using the following procedure. A Phillips screwdriver 
is required to reset the network settings.

IMPORTANT
• Make sure that the printer is not operating before initializing the network settings. If you 

initialize the print server while the printer is printing or receiving data, the received data 
may not be printed properly, or may result in paper jams or damage to the printer.

• If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall, and the Windows Firewall is enabled, you cannot search for the 
printers on a subnet that is different from the one that the computers using NetSpot 
Device Installer are on. To search for such a printer, add NetSpot Device Installer to 
Windows Firewall during the installation.
- Adding "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] 

dialog box (See Readme of NetSpot Device Installer)
- Installing NetSpot Device Installer (See p. 3-35)
Readme of NetSpot Device Installer is in [Readme_English.html] in the following folder in 
the CD-ROM supplied with the network board.
- \NetSpot_Device_Installer\Windows
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• The procedures for removing or installing the network board in this manual may be 
different from those for the printer you are using. For more details on the procedures for 
removing or installing the network board, see "User's Guide".

1 Turn the printer OFF.

2 If a USB cable is connected, turn the computer off, and then 
disconnect the USB cable.

3 Disconnect the power plug from the AC power outlet.

4 Remove all the interface cables and the power cord from the 
printer.

NOTE
If the optional duplex unit is installed, remove it from the printer. For details on the 
procedure for removing the duplex unit, see "User's Guide".

5 Remove the two screws and remove the network board.

IMPORTANT
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

6 Switch the DIP switch 1 (A) to ON.

Set the DIP switches with the tip of a ball-point pen etc.

ERR LNK 100

ON
OFF

1 2 3 4

(A)
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IMPORTANT
When setting the DIP switches, be careful not to damage the main board with the 
tip of a ball-point pen etc. Do not use a sharp object such as a mechanical pencil.

7 Insert the network board into the expansion slot.

Hold the metal panel portions of the network board and insert the board straight 
while aligning it with the guide rails inside the expansion slot.

IMPORTANT
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Insert the network board securely.

8 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

9 Connect the power cord.

10 Plug the power plug into the AC power outlet.

11 Press " " of the power switch to turn the printer ON, wait until 
the Ready indicator comes on, and then press " " of the 
power switch to turn the printer OFF.

12 Disconnect the power plug from the AC power outlet.

13 Remove the power cord.
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14 Remove the network board, then reset the DIP switch 1 (A) to 
OFF.

Set the DIP switches with the tip of a ball-point pen etc.

IMPORTANT
• When setting the DIP switches, be careful not to damage the main board with the 

tip of a ball-point pen etc. Do not use a sharp object such as a mechanical pencil.
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Do not drop screws, paper clips, staples, or other metal objects inside the printer. If 

any of these objects should drop inside the printer, do not plug the power plug into 
the AC power outlet and contact your local authorized Canon dealer.

15 Install the network board.

NOTE
If the optional duplex unit was previously installed, reinstall it on the printer. For 
details on the procedure for installing the duplex unit, see "User's Guide".

16 Connect the interface cables except for the USB cable, and 
connect the power cord.

17 Plug the power plug into the AC power outlet.

18 If you are going to print via USB also, connect the USB cable.

ERR LNK 100

OFF
OFF

1 2 3 4

(A)
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Settings for Adding a Port
Depending on the method for setting the IP address of the printer, the value to be 
entered in [IP Address or Printer Name]* on the following screen displayed in the 
process of adding a port varies.

■ When you want to set the IP address to be assigned to the printer manually 
(When you know the IP address to use):
• Enter the IP address in [IP Address or Printer Name]*.
• When setting the IP address using the DNS server, specify the DNS settings for the 

printer. Then, enter the printer name (the DNS name registered on the DNS server (up 
to 78 characters)) in [IP Address or Printer Name]*. For example, enter the printer name 
as "AAA.BBB.com" if you have specified the host name as "AAA" and the domain name 
as "BBB.com". However, enter "AAA.CCC.com" when you obtain the IP address from 
DHCP etc. that allows you to obtain the domain name (CCC.com) simultaneously.

■ When you want to set the IP address to be assigned to the printer using 
DHCP etc.:
• Set DHCP etc. so that the same IP address is always assigned to the printer when 

starting up the printer. For more details, see "When you want to set the IP address to be 
assigned to the printer manually" above.

• When a different IP address is assigned to the printer each time the printer starts up, 
specify the DNS settings for the printer first. Then, enter the printer name (the DNS 
name registered on the DNS server (up to 78 characters)) in [IP Address or Printer 
Name]*. For example, enter the printer name as "AAA.BBB.com" if you have specified 
the host name as "AAA" and the domain name as "BBB.com". However, enter 
"AAA.CCC.com" when you obtain the IP address from DHCP etc. that allows you to 
obtain the domain name (CCC.com) simultaneously.

*  [Printer Name or IP Address] for Standard TCP/IP Port
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IMPORTANT
If you are using Canon CAPT Port and enter the printer name in [IP Address or Printer 
Name] on the following screen displayed in the process of adding a port and click [OK], 
and proper communication is made, the [Canon CAPT Port - Add Print Port] dialog box 
closes.

If proper communication is not done, the message <Could not communicate with the 
specified printer. Do you want to continue with the entered printer name or IP address?> 
appears. This message will appear when the printer is in the following status etc. If there 
is no problem after checking the specified settings, click [OK]. If you want to change the 
specified settings, click [Cancel].
- The printer is OFF.
- The printer is ON, but there is no response from the device for some reason.

NOTE
• You can use Standard TCP/IP Port only with LBP5100.
• For details on specifying the DNS settings for the printer, see "Protocol Settings Using 

the Remote UI," on p. 2-84.
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Changing the Port
If you changed the IP address or name of the printer (the DNS name registered on 
the DNS server), you need to change the port to be used. The method for changing 
the port varies depending on the type of the port that is being used as follows.

• When you are using Standard TCP/IP Port (See p. 5-18)

• When you are using Canon CAPT Print Monitor (See p. 5-22)

For Standard TCP/IP Port (Only for LBP5100)
If you are using Windows 2000/XP/Server 2003 and are using Standard TCP/IP 
Port, change the port to be used using the following procedure.

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 2000: From the [Start] menu, select [Settings] ➞ [Printers]. 
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes]. 
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] ➞ [Printers and Faxes].

2 Select the icon for your printer, then select [Properties] from 
the [File] menu.
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3 Display the [Ports] sheet, then click [Add Port].

4 Select [Standard TCP/IP Port], then click [New Port].

5 Click [Next].
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6 Enter the new IP address or name of the printer (the DNS 
name registered on the DNS server (up to 78 characters)) in 
[Printer Name or IP Address], and then click [Next].

Depending on the method for setting the IP address of the printer, the value to be 
entered varies. For more details, see "Settings for Adding a Port" (p. 5-16) or ask 
your network administrator.

IMPORTANT
If the following screen appears, search for the printer following the instructions on 
the screen, or from [Device Type] select [Standard] ➞ [Canon Network Printing 
Device with P9100], and then click [Next].
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7 After the computer has confirmed that there is a printer that 
has the IP address you entered, the [Completing the Add 
Standard TCP/IP Printer Port Wizard] window appears. Click 
[Finish].

8 Click [Close].

9 Click [Apply].
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10 Click [OK].

NOTE
To delete an old port, select the port that you want to delete, and then click [Delete 
Port].

For Canon CAPT Print Monitor
If you are using Canon CAPT Print Monitor, change the port to be used using the 
following procedure.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] ➞ [Printers]. 
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes]. 
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] ➞ [Printers and Faxes].
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2 Select the icon for your printer, then select [Properties] from 
the [File] menu.

3 Display the [Ports] sheet, then click [Add Port].

4 Select [Canon CAPT Port], then click [New Port].
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5 Click [Update Printer List].

6 From [Available network printers], select the port of the new 
IP address of the printer, and then click [OK].

If the target printer's port name is not displayed in [Available network printers], 
click [Add to List Manually], enter the IP address or printer name (the DNS name 
registered on the DNS server (up to 78 characters)) in [IP Address or Printer 
Name] in the [Add to List Manually] dialog box, and then click [OK]. Depending on 
the method for setting the IP address of the printer, the value to be entered varies. 
For more details, see "Settings for Adding a Port" (p. 5-16) or ask your network 
administrator.

7 Click [Close].
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8 Click [Apply].

9 Click [OK].

NOTE
To delete an old port, select the port that you want to delete, and then click [Delete 
Port].
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Using the Unicast Communication Mode
Unicast Communication Mode
The unicast communication mode makes communication by using the unicast 
method in sending status from the printer, which is not normally performed by the 
broadcast communication mode.

If you want to use the unicast communication mode, set the network board settings 
to enter into the unicast communication mode using FTP Client.

IMPORTANT
If you want to use the printer in a network environment in which the broadcast 
communication mode is not used, you need to switch the mode to the unicast 
communication mode. However, because this affects the administration of your network 
environment, be sure to consult your network administrator when using the unicast 
communication mode.

NOTE
If the message <Network Board Error> is displayed in the Printer Status Window after 
setting the unicast communication mode, click the [Refresh] button in the Printer Status 
Window.
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Setting the Network Board to Enter into the Unicast 
Communication Mode

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] ➞ 
[Accessories] ➞ [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] ➞ [Accessories] ➞ 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] ➞ [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

Input Example : ftp 192.168.0.215

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

● If the password is specified for the printer

❑ Enter the password.

● If the password is not specified for the printer

❑ Do not enter the password, but press the [ENTER] key on your keyboard.

4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.

IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.
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5 Open the config file downloaded by Notepad, etc.

6 Edit "YES" to "USE_IP_PORT_NAME".

Input Example : USE_IP_PORT_NAME. :YES

7 Save the config file.

8 Enter the following command, then press the [ENTER] key on 
your keyboard.

put <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

9 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).

10 Enter "quit", then press the [ENTER] key on your keyboard.

11 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.

IMPORTANT
To specify the normal mode (the broadcast communication mode), edit 
"USE_IP_PORT_NAME" to "NO".
Input Example: USE_IP_PORT_NAME.:NO

NOTE
If the message <Network Board Error> is displayed in the Printer Status Window 
after setting the unicast communication mode, click the [Refresh] button in the 
Printer Status Window.
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Select the update file, then update the firmware of the print server.

IMPORTANT
• When you cannot update the firmware properly or want to know details on the procedure 

for updating the firmware, see the README file supplied with the firmware.
• Make sure that the printer is not operating before updating the firmware. Do not print 

during the firmware update. Otherwise, the firmware cannot be updated properly.

NOTE
The screen shots used in this section are from Windows XP Professional with which 
LBP5100 is being used.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Network] from the [Device Manager] menu.

4 Confirm the current version of the firmware in [Version], then 
click [Update Firmware].

5 Click [Browse], then select the update file for the firmware or 
enter the path.
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6 Click [Update] to update the firmware.

IMPORTANT
When you cannot update the firmware properly, see the README file supplied with 
the firmware.
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Specifications
Hardware Specifications

Software Specifications

CPU RISC 200MHz

ROM 2MB (flash ROM)

RAM 8MB

Network Interface
10BASE-T/100BASE-TX (RJ-45)
Full duplex; Half duplex

Indicators 3 pieces (ERR, LNK, 100)

Compatible Protocols TCP/IP

TCP/IP Frame Type: Ethernet II

Printing Software

- CAPT (Canon Advanced Printing Technology)
- Windows Standard TCP/IP Port (Port9100)*
* Supported only by LBP5100. Also, supports only Raw, 

but not LPR.
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